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Legal Notices

Warranty

The only warranties for Hewlett-Packard Development Company, L.P. products and services are set forth in the
express warranty statements accompanying such products and services. Nothing herein should be construed as
constituting an additional warranty. HPE shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HPE required for possession, use or copying. Consistent with
FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data
for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2015 - 2016 Hewlett Packard Enterprise Development LP

Trademark Notices

Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
UNIX® is a registered trademark of The Open Group.

Java is a registered trademark of Oracle and/or its affiliates.

Documentation Updates

The title page of this document contains the following identifying information:

« Software Version number, which indicates the software version.
« Document Release Date, which changes each time the document is updated.
« Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:
https://hpp12.passport.hp.com/hppcficreateuser.do

Or click the the Register link at the top of the HP Software Support page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact
your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at: https://softwaresupport.hp.com

This web site provides contact information and details about the products, services, and support that HP Software
offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can benefit
by using the support web site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support
contract. To register for an HP Passport ID, go to:

https://hpp12.passport.hp.com/hppcficreateuser.do
To find more information about access levels, go to:
https://softwaresupport.hp.com/web/softwaresupport/access-levels

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to
explore HP Product Solutions to meet your business needs, includes a full list of Integrations between HP Products,
as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Chapter 1: Troubleshooting HPE Operations Bridge
Reporter

HPE Operations Bridge Reporter (HPE OBR) is a cross-domain historical infrastructure
performance reporting solution. It displays both top-down reports from Business Service
Management (BSM) Business Service and Business Application or HP Operations
Manager (HPOM) Node Group perspective to the underlying infrastructure. It also
displays reports from the infrastructure to the impacted Business Services and Business
Applications or Node Groups. It leverages the topology information to show how the
underlying infrastructure health, performance and availability are affecting your Business
Services and Business Applications or Node Groups in the long term.

Like any other enterprise application, HPE OBR can experience problems in any

IT environment. These problems occur because of the complex behavior of the
application, changing hardware and software demands and infrastructure changes.
Troubleshooting HPE OBR means identifying and diagnosing problems with the aim of
keeping the application functioning optimally.

About this Guide

This guide covers the common problems that you may encounter while using HPE OBR
and provide steps to troubleshoot them. Each problem is documented with a symptom,
the description about the symptom and resolution for the symptom.

When to use this guide?
Use this guide when you:

« Encounter problems in installing, configuring and operating HPE OBR.

« Notice alerts in the HPE OBR Administration Console related to database
connection, data collection, job streams, or services.

o Cannotview any data in the reports.
« Problems in data backup and recovery.
How to use this guide?

This guide is organized into the following sections:

« Troubleshooting Installation Issues
o Troubleshooting Administration Issues
« Troubleshooting Reporting Issues
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Troubleshooting Data Source Issues
Troubleshooting Client Authentication Certificate Problems

Troubleshooting High Availability (HA) Issues
Troubleshooting Disaster Recovery Issues

Target Audience and Prerequisites

The target audience for this guide are the users who work with HPE OBR on a regular
basis and the administrators responsible for maintaining the product. The use of this
guide assumes some prerequisite knowledge. Readers must have a high-level
understanding of HPE OBR features and functions and are expected to have read the
following product documentation:

« Interactive Installation Guide

« Configuration Guide

o Concepts Guide

o Online Help for Administrators

o Online Help for Users

« Release Notes
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Chapter 2: Introducing the HPE OBR Log Files

This section covers the following topics:

» "Configuring DEBUG Levels in the HPE OBR Log Files" below
« "HPE OBR Log File Inventory " on the next page

Configuring DEBUG Levels in the HPE OBR Log Files

Before you can effectively use a log file to troubleshoot a problem, you must have
detailed information about that problem in the specific log file. By default, the log file only
displays INFO, ERROR, or FATAL types of messages. For detailed information, you can
configure HPE OBR to log DEBUG or ALL types of messages in the log file. A

DEBUG type of message provides additional information about a particular error that
occurred rather than just a simple error or warning message. To set the DEBUG level for
a log file, perform the following steps:

1. Open the BSMRLogConfigClient.xml file from the following location:
For Windows: %PMDB_HOME%\config
For Linux: $PMDB_HOME/config

2. Search for a particular log file name and note down its appender name.

For example, to modify the level of the transform. log file, first search for the
transform.log file. Each log file in HPE OBR is associated with an Appender1
componentin the BSMRLogConfigClient.xml file. Searching for the log file
displays the <appender> tag for that log file.

Forthe transform. log file, the following Appender component appears:

<appender name="transformAppender" class="com.hp.bto.bsmr.util logger BSMRRollingFileAppender"s
<param name="File" value="5{pmdb.home}/log/transform.log"/>
<param name="Append" value="true"[>
<param name="MaxFileSize" value="4MB" />
<param name="MaxBackupindex"value="10"/>
<layout class="org.apache.logdj.PatternLayout">
<param name="ConversionPattern" value="%d{IS08601} %5p, %C.%M, %m%n"/=>
<flayout=
<fappender=

A logging framework generates output for multiple destinations, such as generating
output of trace statements to the console or serializing it into a log file. In HPE OBR logs,
the Appender component defines this output medium. These components append
themselves to the Logger component and relay the output to an output stream.
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As shown in the preceding example, for the transform. log file, the appender
name is transformAppender.

3. Search for the appender name string in the file. The Logger component for the
specified appender name is displayed. For example, for the transformAppender,
the following Logger component appears:

<logger name="com.hp.bto.bsmr.transform" additivity="false"=
<level value="INFO" />
<appender-refref="transformAppender"/>
<appender-refref="errorAppender" />
</logger=
4. In the <logger> tag of the string, change the </evel value>from INFO to DEBUG.
5. Save changes and close the file.
Configure DEBUG Levels for the following log files in the location {PMDB_HOME }
/config:
« loader
« aggregate
« DR
« customscript
« pollerDataProcessor
« analyzeStat
To configure DEBUG level for the above mentioned log files, follow these steps:

1. Go to the following path:
On Windows: %PMDB_HOME%/config
On Linux: $PMDB_HOME/config
2. Editthe following field in shrlogger. conf file for aggregate:
log4perl.aggregate.aggregate=DEBUG
where, INFO is the default level.

You can follow the same steps to configure the DEBUG level for other log files in the
shrlogger.conf file.

HPE OBR Log File Inventory

HPE OBR uses the 1og4j APl and log4perl for logging information. It maintains a log
file for each module placed in the following location:

For Windows: %PMDB_HOME?%\ log
For Linux: $PMDB_HOME/log

The following table lists the log files and their location available in HPE OBR:
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Log File

AdministratorServi

ce.log

aggregate.log

aggrgen.log

analyseStat.log

audit.log

autopassJ.log

backend. log

Location on Disk

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/
Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log

Windows: %PMDB__
HOME%\ log\

Linux: $PMDB_HOME/log

Windows: %PMDB_
HOME%\1log\

Linux: $PMDB_HOME/log

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\1log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME /log/

HPE Operations Bridge Reporter (10.00)

Module

Administrator
Service

Aggregate

Aggregate

Database

trendproc,
trendtimer

HPE OBR
Licensing

trendproc,
trendtimer

Description

Contains log messages
related to the service -
HPE_PMDB_Platform
Administrator.

Contains summarized
log messages related to
the data from the rate
tables to the hourly,
daily, and forecast
tables, and from the
hourly tables to the daily
tables.

Contains log messages
related to aggregate
script generation.

Appender:aggrgenApp
ender

Contains log messages
related to Vertica
database maintenance.

Records the start time,
end time, and duration of
back-end processes.
When a process begins,
the file assigns a
Process Identification
(PID) that also records
when the process ends,
showing that the PID for
the process was
terminated.

Contain messages for
license-related tasks.

Appender:
AutopassAppender

Contains log information
for all steps in the data
processing job.
Appender:
backendLogAppender
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Log File

BOEInstall @.log

BusinessObjects.12
.7.1log

BSMRAbcservice.log

BSMRApp. log

BSMRCollectionServ
ice.log

BSMRDBLoggerServic
e.log

bsmrfrontend.log

bsmrim.log

Location on Disk

Windows: <SAP BOBJ
Install
Directory>\BusinessOb
jects Enterprise
12.0\Logging\BOEInsta
11 o.1og

Linux:
/opt/HP/BSM/BO/setup/
logs

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME/log/
Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/
Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

HPE Operations Bridge Reporter (10.00)

Module

Business
Objects

Orchestration

NA

Collector

Logger

Administration
Console

Internal
Monitoring

Description

SAP BusinessObjects
installation log files.

Contains log messages
related to the service
PMDB Platform
Orchestration.

Appender:
abclogAppender

Application-wide log file
that contains error
messages from all the
HPE OBR modules
except data processing.
Appender:
bsmrappender

Contains log messages
related to the service -
HPE_PMDB_Platform_
Collection.

Contains log messages
related to the service -
HPE_PMDB_Platform_
DB_Logger.

Contains log messages
related to the
Administration Console
web application.
Appender:
BSMRFrontEndAppende
r

Contains log messages
related to the internal
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Log File

BSMRIMService.log

catalina*.log

collections.log

collectStep.log

customer.log

cpPatch.log

Location on Disk

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/
Windows: %PMDB_

HOME%\adminServer\log
s

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB_

HPE Operations Bridge Reporter (10.00)

Module Description

monitoring of data
processing job streams,
Performance
Management database
(PMDB) platform, and
Content Packs.
Appender:
BSMRIMAppender

Internal
Monitoring

Contains log messages
related to the service -
HPE_PMDB_Platform_
IM.

Administrator
Console

Contains log messages
about the Apache
Tomcat server that is
used by Administration
Console and

SAP BusinessObjects Bl
launch pad.

Collector Contains log messages
related to the collection
framework such as data
sources configured
collection, job
scheduling, and
maintenance.
Appender:

collectionAppender

Collect Contains log messages
related to the collect step
that moves data from the
{PMDB_HOME}/collect
directory to the {PMDB_
HOME } /stage directory
Appender:

collectAppender

Customer
Enrichment

Contains log messages
on customer enrichment.

Appender:
CustomerAppender

Content Packs @ Patch installation log file.
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Log File

customgroup.log

customscript.log

datetime.log

dbcollector.log

dbdelete.log

dlc.log

Location on Disk

HOME%\log\cppatch.log
Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME /1og/

Windows: %PMDB_
HOME%\1log\

Linux: $PMDB_HOME/log/

Windows: %PMDB__
HOME%\1log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

HPE Operations Bridge Reporter (10.00)

Module

Custom Group

Custom Script

Date, Time
management

Collector

Database

Dimension Life
Cycle

Description

Appender:
cpPatchAppender

Contains log messages
related to importing of
custom groups defined
in an XML file.
Appender:
customgroupAppender

Contains log messages
related to custom scripts
defined for a data
process in data
warehouse.

Appender:
customscriptAppende
r

Contains log messages
related to date and time
maintenance in data
warehouse.

Appender:
datetimeAppender

Contains log messages
related to database
collection.

Appender:
dbCollectorAppender

Contains log messages
related to purging the
data in the database as
per retention rules.
Appender:
DbdeleteAppender

Contains log messages
related to management
of the Dimension Life
Cycle.

Appender:
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Log File

downtime.log

downtimeutility.lo

g

DR.log

dw_abclauncher.log

host-manager*.log

enrich.log

Location on Disk

Windows: %PMDB_

HOME%\1og\
Linux: $PMDB_HOME/log/

Windows: %PMDB_

HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1log\

Linux: $PMDB_HOME/log/

Windows: %PMDB__
HOME%\adminServer\log

S

Linux: $PMDB_
HOME/adminServer/logs

Windows: %PMDB_

HOME%\ log\

HPE Operations Bridge Reporter (10.00)

Module

Downtime

Downtime

Disaster
Recovery

Orchestration

Administration
Console

Location
Enrichment

Description
DLCAppender

Contains log messages
related to configuring
downtime and enriching
the performance data
with configured
downtime information.
Appender:
downtimeAppender

Contains log messages
related to the
reprocessing of
downtime utility.

Appender:
downtimeutilityAppe
nder

Contains log messages
related to Disaster
Recovery.

Contains log messages
related to job streams.
Log messages specific
to a process can be seen
in the process-specific
log file. For example,
loader.log forthe
loader process.
Appender:
abclauncher-
RollinglogFileAppen
der

Contains log messages
about the Apache
Tomcat server that is
used by Administration
Console and

SAP BusinessObjects Bl
launch pad.

Contains log messages
on generic enrichments.
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Log File

hpacollector.log

hpsacollector.log

IAEngine.log

IAEvent. log

License.log

loader.log

localhost*.1log

location.log

Location on Disk

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

%PMDB_
HOME%\adminServer\log
s

Windows: %PMDB_
HOME%\1og\
Linux: $PMDB_HOME/log/

HPE Operations Bridge Reporter (10.00)

Module

Collector

Collector

Internal
Alerting

Internal
Alerting

License

Loader

Administration
Console

Location Enric
hment

Description

Appender:
enrichAppender

Contains log messages
related to collection from
HP Performance Agent
collector.

Appender:
hpaCollectorAppende
r

Contains log messages
related to collection from
HPSA collector.
Appender:
hpsaAppender

Contains log messages
related to Internal Alerts.

Appender:
iaEnginelLogAppender

Contains log messages
related to Internal Alerts.

Appender:
iaEventLogAppender

Contain messages for
license-related tasks.
Appender:
licenseAppender

Contains log messages
related to data loading
from the stage area to
the data store.

Contains log messages
related to Administration
Console and

SAP BusinessObjects
launch pad Server
Access.

Contains log messages
from location
enrichment.
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Log File

manager*.log

mapperStep.log

metadata.log

mybsm. log

nodefilter.log

OvInstallerlLog.txt

packagemanager.log

Location on Disk

%PMDB_
HOME%\adminServer\log
s

Windows: %PMDB_
HOME%\log\

Linux: $PMDB_HOME/log/

Windows: %PMDB__
HOME%\ log\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\log\
Linux: $PMDB_HOME/log/

%temp%\..\HPOvInstall
er\HP-SHR_9.30\HP-

SHR_9.30 <timestamp>_
HPOvInstallerLog.html
%temp%\..\HPOvInstall
er\HP-SHR_9.30\HP-

SHR _9.30 <timestamp>_
HPOvInstallerLog.txt.

%PMDB_

HPE Operations Bridge Reporter (10.00)

Module

Administration
Console

Mapper

Metadata
Repository

MyBSM Integr
ation

Collection

Installer

Package

Description

Appender:
LocationAppender

Contains log messages
related to Administration
Console and

SAP BusinessObjects Bl
launch pad Server
Access.

Contains log messages
related to transformation
of collected data.
Transformation includes
pivot transform, rows
filtering, and so on.
Appender:
mapperAppender

Contains log messages
related to metadata
repository persistence,
access, and
modification.
Appender:
MetadataRepositoryA
ppender

Contains log messages
related to launching of
HPE OBR reports from
the MyBSM console.

Contains log messages
related to the node
filters.

Contains log messages
related to HPE OBR
installer. This also stores
log files for each
component of HPE OBR
suchas LCore
components, OVPerl,
and soon.

Contains log messages
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Log File

pollerDataProcesso
r.log

Postgresql-<date
and time>.log

postinstallconfig.
log

reconcilStep.log

remotepoller.log

reload.log

Location on Disk Module
HOME%\1log\packagemana Manager
ger.log

Windows : %PMDB__ Collector
HOME%\1og\

Linux: $PMDB_HOME/log/
<Postgres_install PostgreSQL
directory>/data/pg_

log

Windows: %PMDB__ Post Install

HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB__ Reconciliation

HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB__ Remote
HOME%\log\ Collector
Linux: $PMDB_HOME/log/
Windows: %PMDB_ Reload

HPE Operations Bridge Reporter (10.00)

Description

related to Content Pack
deployment.

Appender:
pkgmgrAppender

Contains logs related to
data download from
remote collectors to
HPE OBR server.

PostgreSQL log file
information.

Contains log messages
related to HPE OBR
post-install
configuration. Details on
database schema
creation of Vertica,
details on HPE OBR
Management database
schema creation of
Postgresql.

Appender:
postinstallAppender

Contains log messages
related to reconciliation
of collected data.
Appender:
reconcileAppender

Contains log messages
related to configuration
and metadata
synchronization and
data transfer between
HPE OBR server and
the different collectors
configured.

Appender:
remotepollerAppende
r

Log file for the contrib
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Log File

shiftmaint.log

sis_aggregate.log

siscollector.log

sqlexecutor.log

stage.log

stderr*.log

Location on Disk

HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB__
HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\
Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

%PMDB_
HOME%\adminServer\log
s

HPE Operations Bridge Reporter (10.00)

Module

Shift
Management

SiteScope
Collector

SiteScope
Collector

Sql Executor

Stage

Administrator
Console

Description

utility (reload.exe) that
handles reload of failed
data.

Appender:
reloadAppender

Contains log messages
related to populating the
shift fact tables based on
shift configured in
Administration Console.
Appender:
shiftMaintAppender

Contains logs from the
SiteScope aggregate
process that runs as part
of collection service.

Appender:
sisAggrAppender

Contains logs from the
SiteScope collector (for
both GDIland DA).

Appender:
sisCollectorAppende
r

Contains logs related to
the custom
SQL executions.

Appender:
sqlExecutorAppender

Contains log messages
related to data staging,
and purging of staging
area.

Appender:
stageAppender

Contains messages
logged to standard error
by the Tomcat server.

Page 18 of 147



Troubleshooting Guide

Chapter 2: Introducing the HPE OBR Log Files

Log File

stdout*. log

topologycollector.

log

trend.log

TrendTimerService.

log

VC

coIlector/collecto

r.log

Location on Disk

%PMDB_

HOME%\adminServer\log

S

Windows: %PMDB_
HOME%\ log\

Linux: $PMDB_HOME/log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_
HOME/log/

Windows: %PMDB_
HOME%\1og\

Linux: $PMDB_HOME /log/

Windows: %PMDB_
HOME%\ log\VC

collector\collector.1

08
Linux: $PMDB_
HOME/log/VC_

collector/collector.1

og

HPE Operations Bridge Reporter (10.00)

Module

Administrator
Console

Collector

Aggregate,
trendproc,
trendtimer

Trend Timer

VC Collector

Description

Contains messages
logged to standard
output by the Tomcat
server.

Contains log messages
related to topology
collection.

Appender:
topologyCollectorAp
pender

Contains messages for
all back-end processes
of HPE OBR. Each
message specifies the
start and end time for the
logged process.

Contains log messages
related to the HPE OBR
timer service.

VC Collector logfiles
Appender:
vcAppender
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Chapter 3: Troubleshooting Installation Issues
This section of the guide covers possible problems that can cause the HPE OBR
installation to fail and how you can troubleshoot them.

This section lists possible symptoms, description and resolutions for HPE OBR
installation issues and includes the following topics:

HPE OBR Installation Issues

Change the Vertica Data Storage location
Post installation Issues

HPE OBR Uninstallation Issues

Content Pack Installation Issues

Content Pack Uninstallation or Upgrade Issues
HPE OBR Installation Issues

Symptom Installation failure caused by SAP BusinessObjects error

Description While running the HP Software installer, the installation fails and the
following error message is displayed:

SAP BusinessObjects is installed on the system. Please
uninstall it before installing HP SH Reporter.

If you have any component of HPE OBR (such as SAP
BusinessObjects or Vertica) preinstalled or not cleanly uninstalled from
previous uninstallation, the HPE OBR installation will fail because the
installer tries to install the components that are bundled with the
product.

Resolution To resolve this problem, you must clean up the existing components
from the system and rerun the installer. For a virtual system, consider
re-imaging if feasible.

Symptom Installation with username having special character "&" requires
system startup.

Description While installing HPE OBR with username having special character &
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then the system requests for startup.

Resolution Click Continue and proceed with your installation.

Symptom Installation failure due to missing libraries

Description While installing HPE OBR, if there any missing libraries the installation
precheck will fail.

Resolution To resolve this problem, perform the following steps:

1. Go to the following location and get the list of missing libraries:
/tmp/SHR-Missing-Patches.txt

2. Install the missing libraries.

3. Re-initiate HPE OBR installation.

For more information, see the Installation Prerequisites section in HPE
Operations Bridge Reporter Interactive Installation Guide.

Symptom Installation stops during pre-check in Linux operating system

Description While installing HPE OBR on Linux operating system, before selecting
the Typical or Custom option, if the user presses ctrl+c the installation
gets aborted.

Resolution To resolve this issue, follow these steps:

1. Go to the location /tmp/ovii.lck and delete the entries.
2. Run the command:

ps -ef | grep rpm

Kill the processes that are running.

Symptom YUM check warning after HPE OBR installation (Linux only)

Description Afterinstalling HPE OBR and meeting all the pre-requisites, the
following message appears with a list of missing libraries:

Found 42 pre-existing romdb problem(s), 'vum check' output follows:

Resolution If you get a list of missing libraries while performing the YUM check,
you can ignore these libraries as they are not mandatory for HPE OBR.
This does not affect the functionality of HPE OBR.
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Symptom During installation a message appears

An installation configuration file saved from the last time the installer
was run has been found. Do you want to use the values in this file for
the current installation? Please enter your choice (Y/N)

Description During the previous installation of HPE OBR, if the installer gets
aborted for any reason then this message appears when you perform
installation the next time.

Resolution  You can continue the installation by selecting Y. The same
configuration file created by the installer during the previous
installation will be used.

Symptom Unable to bring up HPE OBR services after successful installation
on Virtual machine

Description If HPE OBR is installed on a virtual machine that is not restarted after
the installation, the environment variables set by the installer will not
be available to the user resulting in HPE OBR services not coming up
in spite of multiple retry.

Resolution Afterinstalling HPE OBR, ensure that you restart the virtual machine.

Symptom Install in progress, but the Done button is enabled

Description This issue may appear while performing HPE OBR installation,
upgrade or installing Remote Collectors. The installer progress bar
shows that the installation is in process but the Done button is
enabled. This is because the installer is not refreshed.

Resolution Click Done to complete the process and check the install log files as
follows to see if all the components are installed.

Windows: %temp%/../HP-SHR_9.40 HPOvInstaller.txt
Linux: /tmp/HP-SHR_9.40_HPOvInstaller.txt

Symptom After interrupted installation, unable to continue reinstall with the
installed components (Windows only)

Description This issue may occur when you accidentally quit the HPE OBR
installation wizard and later continue to reinstall with the existing
components.
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Resolution Perform the following steps to resolve this problem:

1. Start the installation wizard and review the Pre-Install Summary.

2. Select the Force repair of already installed component
packages and click Install.

3. Ifthe reinstall fails then, click Rollback in the pop-up message.
The installed components will be removed.

4. Starta new installation.

Symptom Installation fails for Management database package while
installing as Domain user

Description HPE OBR installation fails with domain user during
HPPmdbPostgreSQL package installation with the following errorin
the install log.

C./HP-SHR/Postgres/data ... initdb: could not change permissions of
directory "C:/HP-SHR/Postgres/data": Permission denied in
%temp %\install-postgresql.log (or) %temp %\bitrock_installer.log

Resolution Uninstall HPE OBR and create a local user thatis a member of the
Local Administrators group with administrator rights and install
HPE OBR again.

Symptom Error in install.log - name not found: verticadba

Error getting user information: ‘getpwnam(): name not found:
verticadba

Description After successful installation of HPE OBR and Vertica database
creation, the install.log file has the following error:

ERROR:vertica.system.usergroup.UserGroup:Error getting user
information: 'getpwnam(): name not found: verticadba

Resolution This error can be ignored and you can move ahead with the post-
installation steps.

Change the Vertica Data Storage location

Symptom The Vertica Data Storage location current disk is filled

Description  If the current Vertica Data Storage disk is filled, the location of the disk
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has to be changed.

Resolution Follow these steps to change the location of the disk:

1. Create a new disk and give permission of Vertica User

chown <vertica user>:<vertica user> <Path of new
disk mounted>

2. Run the following command to add the new disk location:

SELECT ADD_LOCATION ('<Path of new disk
mounted>',"'"', 'DATA");

3. Run the following command to alter the location:

SELECT ALTER_LOCATION USE ('<Path of new disk
mounted>"',"'"','DATA");

4. Run the following command to remove the Data location from old
disk:
SELECT ALTER_LOCATION_USE ('<Path of old
disk>',""',"'TEMP');

To verify the new disk is added, run the following SQL query:

select * from disk_storage;

Post Installation Issues

Symptom HPE OBR Fails to Create the Vertica Schema during post
installation

Description The Vertica schema creation step may fail during post-install due to
following reasons:
« Invalid or incorrect hostname given during the postinstall step

« Vertica database had a sudden shut down while performing the
post-install schema creation

Resolution To overcome this issue, follow these steps:

1. From the system where HPE OBR is installed, go to etc/init.d
folder, stop the administrative service by running the following
command:

service HPE_PMDB_Platform_Administrator stop

2. From the system where HPE OBR is installed, go to
/opt/HP/BSM/PMDB/config and delete postinstall folder.
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3. From the Vertica system, drop the database by running the
following command:

su verticadba -c "/opt/vertica/bin/adminTools -t
drop_db -d pmdb"

4. Go to the Vertica datafile location and the catalog file location,
delete the pmdb folder in each using the following commands:
rm -rf pmdb in /opt/vertica/<db file name>
rm -rf pmdb in /opt/vertica/<catalog file name>

5. Gotoetc/init.d folder, start the administrative service by
running the following command:

service HPE_PMDB_Platform_ Administrator start

Symptom Database schema creation failed

Description In a typical installation scenario, after completing the HPE OBR
installation, while performing post-install, following error message
appears:

"Database schema creation has failed/ Sorry cannot
proceed further"”

This is because the user has executed the
createverticadatabase.sh on the system and the vertica database
created during the installation gets overwritten.

Resolution Perform the following to resolve this issue:

1. Go to the location /opt/vertica/config/ and open the
admintools. conf file and check if the Database has the pmdb as
parameter. This ensures that the database is created.

2. Go to the location /opt/HP/BSM/ and open the file
ShrDepolyment. conf and check if the Features Installed
parameter has OBR, BO, and Vertica.

3. Run the following commands to stop and drop the database:

su <Vertica User Name> -c
"/opt/vertica/bin/adminTools -t stop_db -d <Database
Name> -p <Vertica Database Password> -F"

su <Vertica User Name> -c
"/opt/vertica/bin/adminTools -t drop_db -d <Database
Name>"
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4. Perform the post-installation steps again to create the database.

Symptom During post install Vertica database not getting created.

Description During postinstallation, after typing the details to create Vertica
database, the browser gets stuck even after clicking Next.

Resolution Clear the web browser cache, reload the page, and perform the post
install steps again.

Sympt Restarting Postgres service displays warning information in Linux
om

Descri While restarting the Postgres service during post install, the following
ption  warnings are displayed:

Restarting PostgreSQL 9.4:

WARNING --> PERL_INSTALL_PATH is not set in
/opt/HP/BSM/Postgres/etc/sysconfig/plLanguages.config file

WARNING --> PYTHON_INSTALL PATH is not set in
/opt/HP/BSM/Postgres/etc/sysconfig/plLanguages.config file

WARNING --> TCL_INSTALL PATH is not set in
/opt/HP/BSM/Postgres/etc/sysconfig/plLanguages.config file

Resol You canignore the warnings and move ahead with the HPE OBR
ution  configurations.

HPE OBR Uninstallation Issues

Symptom After Uninstalling HPE OBR, Reinstall Fails (Windows only)

Description When you reinstall HPE OBR on a Windows system, the installer fails
to launch and displays a Scripting Host not Found error.

Resolution This error is encountered when the path environment variable is
corrupted in a Windows system. Add the %systemroot%\System32
string to the path environment variable by performing the following
steps:

1. Right-click My Computer, and then click Properties.
2. Click the Advanced system settings, and then click
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Advanced tab.
3. Click Environment Variables.
4. In the System Variable group, select Path.

5. Click Edit and add the string %systemroot%\System32 if
missing.

Symptom After reinstalling a collector on a system, HPE OBR fails to
communicate with the collector

Description  If you uninstall a collector and reinstall it on a system, HPE OBR fails
to communicate with the collector and error messages appear when
you try to configure the collector in the Administration Console.

You can occasionally experience this issue even after installing the
collector for the first time.

Resolution To resolve this, manually import the certificate from the HPE OBR
system to the collector system by following these steps:
1. Log on to the collector system.

2. Run the following command on the command prompt and note
down the ID displayed:

ovcoreid
3. Log on to the HPE OBR system.
4. Run the following command on the command prompt:

ovcm -issue -file <file> -name<node name>-
coreid<core_ID>

In this instance,

<file> is the name of the certificate file that you want to manually
import to the collector system; you must specify the file name with
complete path to the directory where you want to store the file.

<node name> is the FQDN of the collector system.
<core_ID> is the ID that you noted in step 2.

The command prompts for a password. If you do not wantto use a
password, press Enter without typing anything.

5. Transfer the certificate file to the collector system.
6. Log on to the collector system.
7. Run the following command:

ovcert -importcert -file<file>
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Content Pack Installation Issues

Symptom

Description

Resolution

Symptom

Description

Resolution

Content Pack Installation Fails

When installing the Content Packs, the installation process fails, with
ERROR Code 51 with no information for failure in the logs. This may
be because the ovc services are not up and running.

Perform the following steps to avoid content pack installation failure:

1. Check status of your ovc services. To check the status, go to
command prompt, type ovc.

The following error message is displayed if ovc is down.

ssUsepssAdministratorove

tctrl-1112 Ouvcd is not yet started.

2. Start the ovc services which are down.
To start, type ovc -start.

twUszsers~Administrator>ouvc —start

3. Type ovc, to ensure the state of ovc is up and running as shown.

NUserssAdministrator>ove
O Communication Broker (3696)> Running
Ol Control <3968 > Running

O Config and Deploy (3288)> Running
OU Certificate Server SERVER C4452 > Running

Content Packs installation hangs (on Linux only)

Content pack is in the state of Installation Started for more than 1
hour.

To resolve this issue, the SAPBOBJEnterpriseX140 service should be

restarted. Perform the following steps:

1. Log on to the HPE OBR system.

2. Run the following command:
Ps -eaf |grep packagemgrSilent

3. Note down the process id and run the following command:
kill -9 <processid>

4. Go to the location /etc/init.d.

5. Run the following commands:
service SAPBOBJEnterpriseXI4@ stop
service SAPBOBJEnterpriseXI40 start
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6. Uninstall the Content pack which is in the started mode and start
the Content pack installation again.

Symptom  Reinstallation of Content Packs Fails on Windows

Descriptio Reinstallation of Content Packs fails on Windows.
n

Resolution Follow these steps:

1. Check the %pmdb_home%/stage/failed_to_load folder and
look for files with the names of stage tables related to the
Content Pack that you are not able to reinstall. You can find
stage table names in the %pmdb_
home%/packages/CoreContentPack.ap/CoreContentPack
.sql file.

Identify the files with names that contain the name of a stage
table that is related to the Content Pack that you want to
reinstall and then delete them.

2. Start the reinstallation process again.

Content Pack Uninstallation Issues

Symptom Content Pack Uninstallation Fails

Description When uninstalling the Content Packs, the process fails and the
following error message is displayed in the %PMDB_
HOME%\log\trend.log file:

SQL Anywhere Error -210: User 'pmdb_admin' has the row
in '<table_name>' locked

This failure occurs when one or more database connections have a
shared lock on a database stage table.

Resolution To verify if the tables are locked, perform the following steps:

1. Open the Interactive SQL Java console.

2. In the Connect dialog box, on the Identification tab, select
Supply user ID and password.

3. Type the user name and password, click OK.

4. Under SQL Statements, type commit, click Execute all SQL
statement(s) to run the command.

HPE Operations Bridge Reporter (10.00) Page 29 of 147



Troubleshooting Guide
Chapter 3: Troubleshooting Installation Issues

5. Type sp_iqlocks, click Execute all SQL statement(s) to run
the command.

If locked tables still exist, other SQL sessions might be open that you
must close. If there are no locked tables, you can proceed with
uninstalling the Content Packs.

Symptom No right to access data in this Universe error

Description \When you upgrade an HPE OBR Content Pack, the Universe
connections are recreated. If you have specific user access levels
enabled, you must re-assign the access after completing the upgrade.

By default, the administrator will have complete access to the Universe
connections. You may see the following error if the user access levels
are not enabled:

Refreshing Data

“ou do not have the right to access data in this
@ universe. See yvour Businesz0Objects administrator.

(Error: WIS 00505)

Resolution If you have applied access restriction at each user or group level other
than administrator user, you must grant same access restrictions again
for the universe connection.

For more information about enabling user access levels, see the SAP
BusinessObjects documentation available at http:/<Host
DNS>:8080/CmcApp/help/en/administration/htmi/default.htm
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Chapter 4: Troubleshooting Administration Console
Issues

The HPE OBR Administration Console is a web-based monitoring tool that you can use
to monitor various components of HPE OBR, such as data collection, data processing,
database, services, and so on. If a problem occurs, appropriate alerts are displayed on
the Administration Console.

This section of the guide covers how to troubleshoot the alerts that appear on the
Administration Console. In addition, this section also covers some of the commonly
encountered problems during data collection, data reconciliation, data processing, or
while performing certain administrative tasks.

The Home page of the Administration Console gives you an overall view of the status of
HPE OBR, its associated services, the database, and the host platform.

When a problem occurs with any HPE OBR component, the Home page displays an
alerticon so that you can investigate and take appropriate action.

This section of the guide covers the following HPE OBR-related alerts and the steps you
must perform to resolve them:

o Administration Console Log on/Launch Issues
o Understanding Data Collection Alerts

» Understanding Service Alerts

« Understanding Database Alerts

« Understanding Orchestration Alerts

Administration Console Log on/Launch Issues

Symptom Unable to Log on to the Administration Console

Description After entering the user credentials in the Administration Console and
clicking Log in, the following error message is displayed:
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Windows Intermet Explorer [ X

Q Internet Explorer cannot open the Internet site
" httpyf example hp.com:21411/BSMRApp/indexjsp.

Operation aborted [:«3

| |

Resolution Clear the web browser cache, reload the page, and perform the steps
again.

Symptom After installation, user is unable to perform post-install steps

Description After installation, when you click Next in the console, the subsequent
page does not load despite enabling JavaScripts to run.

Resolution This occurs when the system date on the HPE OBR system is much
older than that of the ESX (in case of a VM). In such a scenario, the
Tomcat server does not allow any requests from the client. Hence, it is
always advisable to update the system date to current and install.

Perform the following steps:

1. Change system date to current.
2. Apply the permanent license.

When the system date is changed by more than three months,
the license expires.

3. Restart Administration service, Tomcat and SAP
BusinessObjects servers.

4. Log on and perform the post configuration again.

Symptom Error Seen in Administration Console

Description The Administration Console displays the following Windows error
message:
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Resolution

Symptom

Description

Resolution
1

Resolution
2

Resolution
3

Resolution

HPE Operations Bridge Reporter (10.00)

21 Windows Internet Explorer

i Errors on this webpage might cause it to work incorrectly

To see this message in the future, double—dick the warning icon on the status bar.

HTML Parsing Error: Unable to modify the parent container element before the child
element is closed (KB927917)

index.jsp Line: 0
Code: 0 Char: 0
URI: http:/fbd86vm 10: 2141 1/BSMRApp findex. jsp

Ol Always show this message for webpage errors [ Copy error details ]

=) Hide details

Clear the web browser cache, reload the page, and perform the steps
again

Administration Console Web Page Error

When you log on or browse through the Administration Console, the
following error message is displayed on the web page:

500 Internal Server Error:

Check the BSMRApp . log file for duplicate id exception.

This error occurs because of duplicate IDs that were created for the
same web page. To resolve this, clear the web browser cache and
refresh the page.

Restart the Administrator service as follows:
Windows:

« Go to Start > Run, type services.msc.

« Right-click on HPE_PMDB_Platform_Administrator and click
Restart.

Linux:

Run service HPE_PMDB_Platfrom_Administrator restart.

On Linux only: You must make sure that the DISPLAY is not set.
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4 1. Run the command env and check if DISPLAY is set.
2. Ifthe DISPLAY is set, run the following command:
unset DISPLAY

3. Run the following commands to stop and start the Administrator
service:

service HPE_PMDB_Platform_Administrator stop
service HPE PMDB_Platform Administrator start

Symptom Internet Explorer 9 Fails to Launch the Administration Console

Description HPE OBR Administration Console does not launch with Internet
Explorer 9.

Resolution Launch the Administration Console after opening Internet Explorerin
the Compatibility Mode.

Symptom Unable to log on to Administration Console

Description When you log on to the Administration Console with the Administrator
privileges, the following error message is displayed on the web page:

Login Error: User does not have permission to access Administration
Console.

This may appear if the log on credentials are not typed correctly or
config.prp file is corrupted.

Resolution Log on to the Administration Console again by typing the username
and password. If the problem still occurs then to resolve this symptom,
follow these steps:

Windows:

« Go to Start > Run, type services.msc.

« Right-click on HPE_PMDB_Platform_Administrator service and
select Stop.

« Go to the location where you have taken the backup of config.prp
file and copy the backup to the config.prp file location: %PMDB_
HOME%\data\config.prp.

« Go to Start > Run, type services.msc.

« Right-click on HPE_PMDB_Platform_Administrator and select
Start.
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« Log on to the Administration Console.
Linux:

« Run the following command:
service HPE_PMDB_Platfrom_Administrator stop

« Go to the location where you have taken the backup of config.prp file
and copy the backup to the config.prp file location: $PMDB__
HOME/data/config.prp.

o Run the following command:
service HPE_PMDB_Platfrom_Administrator start
« Log on to the Administration Console.

Symptom  Connection to RTSM Server through Administration Console Fails

Descriptio When the user changes the application root context in BSM9.2x, test
n connection fails. BSMRApp . 1og shows following message:

Failed to connect with
http.//<HostName>:21212/setup 1/axis2/services/UcmdbService for
CMDB,

org.apache.axis2.AxisFault: Service not found operation terminated.

Resolution Follow these steps in HPE OBR Server:

1. Edit config.prp file located at %PMDB_
HOME%/data/config.prp (Windows), $PMDB_
HOME/data/config.prp (Linux)

2. Modify
ucmdbservice.url=/axis2/services/UcmdbService to
ucmdbservice.url=/setupl/axis2/services/UcmdbServ
ice (assuming new root context is setup1)

Follow these steps in BSM System:
1. After you have changed the root context from BSM/jmx-console,

stop the server and edit the following configuration files.
Assume that your new root context is setup1.

2. Editthefile . .\HPBSM\odb\deploy\axis2\WEB-
INF\web.xml and add the following lines:

<init-param>
<param-name>axis2.find.context</param-name>

<param-value>false</param-value>
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</init-param>

3. Editthe file . .\HPBSM\odb\deploy\axis2\WEB-
INF\conf\axis2.xml and add the following line:

<parameter name="contextRoot"
locked="false">setupl/axis2</parameter>

4. Restart the server.

Symptom SAP BusinessObjects Bl Launch pad log on from VM Fails

Description After launching the SAP BusinessObjects Launch pad from the
Administration Console on a virtual machine, log on fails despite
providing correct user credentials.

Resolution  This problem occurs if HPE OBR is installed on a virtual machine and
at the time of installation, the host name on the virtual machine is not
correctly set. The HPE Software installer configured SAP
BusinessObjects using the incorrect host name. However, the installer
used correct host name in the %PMDB_HOME%/data/config.prp file.
Ideally, the installer should use the same host name across all
components. To resolve this problem, perform the following steps:

1. Click Start and type Central Configuration Manager in Search.
The Central Configuration Manager window opens.

2. Right-click Apache Tomcat 5.5.20, and then click Stop to stop
the Tomcat service.

3. Right-click Server Intelligence Agent (OBR) and then click Stop
to stop the SIA service.

4. Right-click Server Intelligence Agent (OBR) and then click
Properties. The Server Intelligence Agent (HOMLO1GEATON)
Properties dialog box opens.

5. On the Configuration tab, select the Change Cluster Name to
check box, and then type the new name of the virtual or physical
machine. Click OK.

6. Right-click Server Intelligence Agent (OBR) and then click Start
to restart the SIA service first.

7. Right-click Apache Tomcat 5.5.20 and then click Start to restart
the Tomcat service next. Close the Central Configuration
Manager window.

8. In the Administration Console, click Administration > SAP
BOBJ. The SAP BusinessObjects page opens.
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9. Click Bl Launch pad. The BusinessObjects Launch pad Login
page appears.

Symptom SAP BusinessObjects Bl Launch pad and CMC Fails to Launch
from Administration Console

Description The links provided in the HPE OBR Administration Console fail to
launch the HPE OBR Launch pad and Central Management Console
(CMC). This might occur because the Fully Qualified Domain Name

(FQDN) of the HPE OBR host system was unavailable or failed to
update.

Resolution In the HPE OBR system, perform the following steps:
1. Go to the path {PMDB_HOME }\data

2. Openthe config.prp file and check if the bo. cms parameter has
the fully qualified name of the HPE OBR system

Understanding Data Collection Alerts

The home page of the Administration Console monitors and displays the status of the
data collected by HPE OBR from the various data sources, such as Runtime Service
Model (RTSM), HP Operations Manager (HPOM), Business Service Management
(BSM) database, and HP Performance Agent (PA).

Following is the image of Collection Status Pane:

Collection Status —h =]

Total (%] @

BTSHK 1 0

o
BA 32 4 13
ProfileDB 0

0

Two types of collection status information are displayed in the Collection Status pane of
the home page, as indicated by the following icons:

« @ Indicates that the collection from the specific data source failed.
« @ Indicates that the collection never started from the specific data source.

For detailed information about the collection status, you can click the hyperlink of the
data source type in the Collection Status pane to open the respective data source page.
For example, clicking RTSM opens the Service Definition page.
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This section of the guide explains the possible problems that might cause the collection
to fail and the steps you must take to resolve these problems.

Data Collection Issues

Symptom

Description

Resolution

Symptom

Description

Resolution

Data Collection not Started or Failed

The Collection Status pane on the home page lists the RTSM or
HPOM data source in the @ column. This indicates that the topology
collection never started from these data sources.

The data source that you are trying to connect to might be down and no
connection is established. To resolve this problem, perform the
following steps:

1. Check the connection status:
a. RTSM, HP OM

In the Administration Console, go to the Data Source
Configuration > Topology Source page to check the status
for the RTSM or HPOM data source.

b. ProfileDB, OMi, HPOM

In the Administration Console, go to the Data Source
Configuration > BSM/OMi > ProfileDB page to check the
status for the ProfileDB data source. Similarly, for Operations
Managementi (OMi) software, go to the OMI page and for
HPOM, go to the Operations Manager page.

c. Click Test Connection to test the data source connection
(double check the credentials using the configure option). In
case the Test Connection check fails for any of the above
scenarios, see the "Troubleshooting Data Source Issues” on
page 89 section.

Data Collection Failure across all Configured Nodes

Data collection in HPE OBR fails with an address already in use error
logged in the topologycollector. log file.

This error occurs when the number of TCP/IP ports used exceeds the
default value of 5000. To resolve this problem, you must make
changes in the Windows Registry. Follow these steps:

1. Click Start > Run. The Run dialog box opens.
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2. Inthe Open box, type regedit. The Registry Editor window
opens.

3. On the left pane, HKEY LOCAL _MACHINE > SYSTEM >
CurrentControlSet > Services> Tcpip, and then click Parameters.

4. On the right pane, right-click anywhere, point to New, and then
click DWORD Value to add a new entry. Add the following
entries:

m MaxUserPort = 65535 (decimal)
m MaxFreeTcbs = 65535 (decimal)
m MaxHashTableSize = 65535 (decimal)
m TcpTimedWaitDelay = 30 (decimal)
Restart the system after making changes in the Registry Editor.

Troubleshooting Data Collection Problems
Symptom PostgreSQL Query Performance Degrades due to Lack of Proper
Statistics Gathering

Description The PostgreSQL slows down and the query performance also
degrades due to lack of proper statistics gathering.

Resolution To resolve this problem, perform the following steps:

o Fromthe {PMDB_HOME}/1ib folder, open the trendtimer.sched
file.

« Enable the following query by removing the # sign:

{PMDB_HOME}/bin/mgmtsqlexecutor -sqlscript {PMDB_
HOME}/scripts/vacuum_postgres.sql

Symptom No Data or Metadata Movement in HPE OBR

Description Data movement does notoccurand a “corruption detected”
message is displayed when an attempt is made to verify the status
(using the ovc -status check command).

Resolution Restart the system.

Symptom No Data Collection due to Remote Poller Exception

Description Policy Owner reports an issue when Remote Poller is distributing the
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policy. Remote Poller sync does not occur for the specific domain and
data collection does not initiate.

Resolution Perform the following steps to resolve the issue:
« Enable DEBUG mode for RemotePoller in the following file: {PMDB_
HOME }/config/BSMRLogConfigClient.xml
« Run the following collection configuration command:

collection_config -collect {PMDB_HOME}/lib/<*_
DBCollector.xml> -cp <ETL Package name>

Example

collection_config -collect {PMDB_HOME}/lib/OM_
DBCollector.xml -cp ETL_OM

« Open the RemotePoller log and search for the Header xml that is
named in this pattern—shr-xxxxxxxxxxxxxxxxx_header.xml—
identify the file including its path.

« Run the following command:

ovpolicy -install -file <absolute path of the header
xml file> -ovrg server

The following output is generated:
<Cannot install because owner of the policy is xxx>

« Open the header xml and obtain the content of policy owner tag.

« Run the following command:
ovpolicy -setowner -ovrg server -polid <shr-
XXXXXXXXXXXXXX XXX >

« Run the following command in the prompt:
ovcreg -add {PMDB_HOME}/config/shr.xml

« Run the following collection config command:

collection_config -collect {PMDB_HOME}/lib/OM_
DBCollector.xml -cp ETL_OM

Symptom No Data Collection from Profile DB/Management DB/OMi Event
Data source

Description When changes are made to the Profile DB/Management DB/OMi Event
database collection configurations for more than once, it leads to piling
up db_poller_map (Postgres) table with invalid or old entries. Remote
poller sync fails and database domains are not discovered in {PMDB__
HOME}/config/ds/db_©_domainmap_©_ local.csv.
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Resolution To resolve this problem, perform the following steps:

« Log on to Postgres database using PgAdmin.
« Identify the invalid domain map IDs:

SELECT * FROM db_poller_map where db_fk NOT IN
(SELECT db_id FROM dict_db_ds)

« Delete the invalid domain map IDs:

DELETE FROM db_poller_map where db_fk NOT IN (SELECT
db_id FROM dict_db_ds)

« Run the following local poller utility commands from the console
(Linux shell or Microsoft Windows Command Prompt).

o remotepollerutility -syncds -type DB -pollername
local

e remotepollerutility -syncpolicy -type DB -
pollername local

 Verify the updated entries in {PMDB_HOME } /config/ds/db_0
domainmap_© local.csv

Symptom HPE OBR Reconciliation Infinitely Reprocesses Failed-to-
Reconcile Files and Degrades System Performance

Description HPE OBR data reconciliation step endlessly reprocesses files that
failed to reconcile and utilizes massive system resources.

Resolution HPE OBR Reconciliation reprocesses files in the $PMDB_
HOME\stage\failed_to_reconcile folder for three days. After three
days, HPE OBR moves the files to the $PMDB_HOME\stage\failed_
to_reconcile\archive folder and stops reprocessing them. If you
want to process the files again, manually move them back to the
$PMDB_HOME\stage\failed to_reconcile folder.

You can also change the default days in the property values from the
folder $PMDB_HOME\collect\property.

For Example:
dbcollector.fail.files.reprocess.interval.mins=4320 and
reconcile.fail.files.reprocess.interval.mins=4320

Symptom HPE OBR Collector Infinitely Reprocesses Failed-to-Process Files
and Degrades System Performance
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Description HPE OBR Collector reprocesses files in the $PMDB_
HOME\collect\temp folder for three days. After three days, HPE OBR
moves the files to the $PMDB_HOME\collect\temp\archive folder
and stops reprocessing them. If you want to process the files again,
manually move them back to the $PMDB_HOME\collect\temp folder.

Resolution  You can also change the default days in the property values from the
folder $PMDB_HOME\collect\property.

For Example:
dbcollector.fail.files.reprocess.interval.mins=4320 and
reconcile.fail.files.reprocess.interval.mins=4320

Symptom Data Gaps in Reports due to no Data Collection from Nodes

Description HPE OBR reports show data gaps when data is not collected from a
node or when a node is a newly added.

When collection for a node resumes after an outage (node is down, or
connection issues, or connection disable/enable through Performance
Agent data source page), the HPE OBR Collector collects data from
the last point within the max-history limit.

When a new node added to HPE OBR, the HPE OBR Collector
collects data based on the init history configuration. By default, after
the first init history data processing, data aggregation processes data
for only the last two days.

Resolution By default, HPE OBR aggregates data from nodes for only the last two
days. To aggregate data older than two days, run the hourly and daily
aggregation commands manually using the following options:

aggregate config=<xml file name> processall=true
execute=true (The XML file is available in the PMDB_HOME/scripts
folder)

Example:

aggregate config= %PMDB_HOME%\scripts\SR_SM CPU_SH SM _
CPU_Hourly CPU_Details.xml processall=true execute=true

Symptom No Data Collection from Network Performance Server

Descripti Data collection of both topology and fact from Network Performance
on Server (NPS) stops, but files keep accumulating in the %pmdb_
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home%\extract\temp folder.
The dbcollector. log file reports the following error:

Error -210: User ‘'another user' has the row in 'd_
ComponentTopology' locked

This occurs because the d_ComponentTopology table is being updated
at exactly the same time when HPE OBR queries for data.

Resolutio In NPS, modify the update time of the d_ComponentTopology table to a

n different value. Otherwise, in HPE OBR, from the PMDB_
HOME/config/collection.properties file, setthe parameter
relative.schedule.type=true and restart the data collection.

Symptom No Data Collection in HPOM Topology from Host resulting in
Empty Reports

Description Data collection from a host does not occur even though it is discovered
and configured for collection. When HPE OBR is unable to connect to
the HP Performance Agent during the dimension collection run that
occurs every 12 hours (720 minutes), fact collection does not occur
and reports do not show any data.

Resolution Decrease the default dimension collection interval value of 12 hours
(720 minutes). In the {PMDB_HOME }
/config/collection.properties file, decrease the value of the
sn.dim.collection.interval.mins property to a number higher
than and a multiple of 60.

Symptom No Data Collection from Host and Empty Reports

Description Data collection from a host does not occur even though it has been
discovered and configured for collection. The issue might be that the
connection to CODA for that host has been lost resulting in data
collection failure. In such cases, Collection has a feature called
blacklisting that marks a node when connection to the same fails while
hourly collection is happening. Once marked, after every 2 retries at a
particular run interval, the same is doubled for the next couple of runs.
This continues till the run frequency reaches 24 hours after which it
remains the same. So collection from that host is initiated once a day
only. During these runs, at any time if the host is reachable again, then
the run interval is reverted to the initial collection schedule frequency of
the host (1 hour by default). Also, the list of blacklisted hosts can be
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seen at any point by connecting to the Java JMX console for Collection
Service at port 21409 under the Collection Administration Mbeans
section.

Resolution Ensure that the node is reachable and responding and also that the

CODA services are running on the same. Once done, restart Collection
Service on the HPE OBR collector.

Symptom Error Message in the aggregate.log File for Procedure not found

Description The aggregate.log file (available under the $PMDB_HOME/log

directory on Linux and the %PMDB_HOME%\ 1og directory on Windows
shows the following error messages:

Procedure 'xxx-xxx-xxxx-xxx' not found
Failed to execute aggregate SQL

Completed aggregate <XML_file> with error

Resolution  To resolve this problem, log on to the HPE OBR system as

30T 3I<W”

w)

es
cri

pti

es
ol
uti

administrator or root, and then run the following command:
aggregate config=<XML_file> regenerate=true

where, <XML_f1ile> is the file name displayed in the error message.

Missing Data Source Metadata Files

Missing Data Source Metadata Files
Windows: %PMDB_HOME%/config/ds folder
Linux: $PMDB_HOME/config/ds folder

1. The data source metadata CSV files are of the form
pa*.csv, cmdb*.csv, sn*.csvanddb*.csv

2. Ensure that all expected data sources are configured by verifying through the
Administration Console.
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o 3. Run the command ovconfchg -edit and check whether the following
n entries are present in the configuration settings page:

« Windows:
[sec.cm.client]
CERTIFICATE_SERVER=<server>
[sec.core]
CORE_ID=82553e92-dbd2-7566-0dd9-1f9a20a672df8
[sec.core.auth]
MANAGER=<server>
MANAGER_ID=82553e92-dbd2-7566-0dd9-f9a20a672df8

o Linux:
[ctrl.env]

LD_LIBRARY_PATH=:/opt/HP/BSM/Sybase/IQ-15
4/1ib64:/opt/HP/BSM/JRE64/1ib/amd64/server:/opt/HP/BSM/Syb
ase/shared/JRE-6_0 24
64BIT/1ib/amd64/server:/opt/HP/BSM/JR64/1ib/amd64:/opt/HP/
BSM/JRE64/1ib/amd64: /opt/HP/BSM/JRE64/1ib/amd64/xawt:/opt/
HP/BSM/Postgres/lib:/opt/0V/1ib64:

PATH=/opt/HP/BSM/JRE64/bin:/usr/kerberos/sbin:/usr/kerbero
s/bin:/usr/

local/sbin:/usr/local/bin:/sbin:/bin:/usr/sbin:/usr/bin:/o
pt/HP/BSM/PMDB/bin:/opt/0OV/bin:/opt/0V/1ib64:/opt/HP/BSM/S
ybase/IQ-15 4/bin64:/root/bin

PMDB_HOME=/opt/HP/BSM/PMDB

[sec.cm.client]
CERTIFICATE_SERVER=<server>
[sec.core]
CORE_ID=26e40652-de97-7566-1f14-b683668d176a
[sec.core.auth]
MANAGER=<server>
MANAGER_ID=26e40652-de97-7566-1f14-b683668d176a

4. Ifthe ctrl.env values are not set on Linux, run the following commands:

a. /opt/0V/bin/ovconfchg -ns ctrl.env -set LD_LIBRARY_PATH
:/opt/HP/BSM/Sybase/IQ-16_
0/1ib64:/opt/HP/BSM/JRE64/1ib/amd64/server:/opt/HP/BSM/Sy
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base/shared/JRE-6_0_ 24
64BIT/1ib/amd64/server:/opt/HP/BSM/JR64/1ib/amd64:/opt/HP
/BSM/JRE64/1ib/amd64:/opt/HP/BSM/JRE64/1ib/amd64/xawt: /op
t/HP/BSM/Postgres/lib:/opt/0V/1ib64.

b. /opt/0OV/bin/ovconfchg -ns ctrl.env -set PATH
/opt/HP/BSM/JRE64/bin:/usr/kerberos/sbin:/usr/kerberos/bi
n:/usr/local/sbin:/usr/local/bin:/sbin:/bin:/usr/sbin:/us
r/bin:/opt/HP/BSM/PMDB/bin:/opt/0OV/bin:/opt/0V/1ib64:/opt
/HP/BSM/Sybase/IQ-16_0/bin64:/root/bin

c. /opt/0OV/bin/ovconfchg -ns ctrl.env -set PMDB_HOME
/opt/HP/BSM/PMDB

5. Runthe command ovc -status -level 8 and in the output check
whether the shrcb component is listed.

shrcb HPE OBR Policy call backs shrcb (3053) Running
-> START attempted at Tue Apr 30 16:11:52 2013

-> Entered STARTING state at Tue Apr 30 16:11:52 2013

-> Entered STARTED state at Tue Apr 30 16:11:52 2013

Note: The component need not be running, but may be stopped or
aborted. However, the listing should include the shrcb component. If this
component is not listed, run the following command:

On Linux: /opt/0V/bin/ovcreg -add
/opt/HP/BSM/PMDB/config/shr_ux.xml

On Windows: %ovinstalldir%/bin/ovcreg -add %PMDB_
HOME%/config/shr_win.xml

6. When the above changes are made, run the ovc -restart command.

7. Runthe remotepollerutility -syncds -pollername local command to
sync all collection data sources to the local collector. To sync data sources
to other remote collectors configured, run the same command by changing
local to the name that was used to configure the remote collector in the
Administration Console.

Symptom Policy and Data Source Report Collector Error
Description Policy and Data Source Report Collector Error

Resolution 1. Check if the collector is reachable. From Administration
Console, go to Data Source Configuration > HP Operations
Agent. Select a host from the Host name column and click
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Test Connection.

2. Check if the certificate installation is correct by running the
ovcert -check command.

Symptom No Collection due to OVCONFD Service not Running

Description OVCONFD service stops due to disk space full situation and does not
start automatically once the space issue is resolved.

Resolution = Run the following command.

1. Check the status of the service.
ovc -status
2. Check the status of ovconfd in the output.
3. Ifitis stopped, execute the START command.
ovc -start ovconfd.
This will start the service and collection of data would continue.

Symptom Collection not occurring from Collector

Description No dimension CSVs or Fact CSVs are available in %PMDB_
HOME%\collect folder (Windows), $PMDB_HOME/collect (Linux). No
data is available in the reports for these hosts.

Resolution 1. Check for connection-related issues to the collector from
Administration > Collector Configuration page in the
Administration Console.

2. Check %PMDB_HOME%\1log\remotepoller. log file for
Windows and $PMDB_HOME/log/remotepoller. log for
Linux and verify errors during data download from the
collectors.

3. Checkifplatform_poller_data_process streamfrom
PMDB_Platform is in error state or is yet to process the
collected data. Log on to Administration Console and check
the status of the above mentioned stream.

4. Check whether the collection policies are installed on the
collector system.

Symptom Fact Collection is Occurring and Data is Available at extract
Folder but not picked by Streams
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Description

Resolution

Symptom

Description

Resolution

Fact CSVs are collected from the source by the collector and available
at the following location %PMDB_HOME%\extract (Windows), $PMDB_
HOME /extract (Linux). But the corresponding Orchestration stream in
the Administration Console shows the collect step status as not
started.

The only reason it can happen is because the platform_poller_
data_process stream from PMDB_Platformis in error state oris yet to
process the collected data.

If the process is running for a longer time, kill the process. Ifitis in error
state, perform the following:

1. Log on to Administration Console and check the status of the
above mentioned stream. ABC stream will automatically process it
next time.

No Fact Collection despite configuring Service Definition

Fact CSVs are not available at the following location %PMDB_
HOME%\collect (Windows), $PMDB_HOME/collect (Linux).

To resolve this problem, perform the following steps:

1. Runovpolicy -1list and check whetherthe Configuration
Management Database (CMDB) collection policies are installed on
the collector. Alternatively, you can also check for collection policy
XMLs in

Windows: %PMDB_HOME%\config\collection_ policy folder
Linux: $PMDB_HOME/config/collection_policy folder

2. Verify whether dimension collection is occurring or not and
whether there are any VIEW*NODEDOMAIN*csv in collect folder.

3. Log on to Administration Console and ensure that the platform_
poller_ds_process stream under PMDB_ Platform group is notin
error state. This is the stream that brings in all NODEDMAINMAP csv
from various collectors and then performs PA node distribution
among collectors.

4. Also, ensure if any remote collectors are configured. If yes, PA data
source distribution is appropriately done via the Administration
Console for all collectors. Because, in case of local-only collector,
all the PA nodes discovered during topology collection are
automatically assigned to the local collector. But, even if a single
remote collector is configured, the distribution of nodes is
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performed based on rules or manual assignment done by the
administrator.

Symptom No Dimension or Fact Collection despite Configuring Data
Sources

Description After configuring the respective data source through Administration
Console (RTSM/HPOM), the respective dimension or fact CSVs are
not collected by the collector.

Resolution To resolve this problem, perform the following steps:

1. Check topologycollector. log file under the following folder
location to check for obvious errors:

Windows: %PMDB_HOME%\ log
Linux: $PMDB_HOME/log

2. Check if the appropriate collection policies are installed on the
collector by either checking for files in %PMDB__
HOME%\config\collection_ policy folder (Windows)/ $PMDB_
HOME/config/collection_policy (Linux) or by running the
ovpolicy -list command.

3. Check for existence of cmdb_©_*.csv or sn_© *.csvin %PMDB_
HOME%\config\ds folder for Windows or $PMDB__
HOME/config/ds for Linux (depending on RTSM and OMSN
configuration respectively) and verify that the details of the data
source configured is correctly present in these files.

Symptom Collection not working after Operations Agent is Uninstalled

Description Ensuring Continuous HPE OBR Collection on the System after HP
Operations Agent is Uninstalled from a system where HPE OBR and
HP Operations Agent coexisted

Resolution If HP Operations Agent is uninstalled, you must perform the following
steps to ensure an error-free collection of data by the HPE OBR
system:

1. On the system where HP Operations Agent was uninstalled, run
the following command:
ovcert -certreq

2. Run the following command on the HPE OBR system:

ovcm -listpending -1
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Note the request ID.
3. Run the following command on the HPE OBR system:
ovcm -grant <request ID from the earlier step>
4. Run one of the following commands:
a. To verify the connectivity to the HPE OBR local collector:
ovdeploy -env PMDB_HOME -ovrg server

The value of the PMDB_HOME environment variable from the
HPE OBR system appears.

b. To verify the connectivity to the HPE OBR Remote Collector:

ovdeploy -env PMDB_HOME -ovrg server -host
<remote collector hostname>

The value of the PMDB_HOME environment variable from the
HPE OBR Remote Collector appears.

Understanding Orchestration Alerts

To troubleshoot problems related to data processing, check the Orchestration Alerts
table on the home page of the Administration Console. The 10 latest active data
processing alerts encountered by the HPE OBR work-flow framework are displayed.

Figure 3: Orchestration Alerts

Stream Name # ‘ Step Name | Meszage ‘ Time

OM@OM_Facts_MessageCount Procedure Dail... C.WINDOWSsystem32="E:HP-SHRPMDB/bin/sglexecutor” -sgl.. Jan 18, 2011 3:05:40 PN

Virtual Env_Management@Facts_LogicalSystem  Procedure Popul.. | CWINDOWSsystemd2="E:HP-SHRPHDB/bin/zglexecutor” -zgl..  Jan 18, 2011 3.06:09 PN

Two types of alerts are generated by this workflow framework:

« Errors: This alertis generated when an active job stream fails to complete the
execution process because of a serious error during the job. This halts the execution
of the job stream.

« Maximum execution time exceeded: This alert is generated when a job is still
running and fails to complete within the defined execution time frame.

Viewing Details of an Alert

To view details of the displayed alert, click the hyperlink in the Step Name column of the
table. An alert details window opens.

Figure 4: Alert Details Window
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Step Mame Reconcile_data
Process Id 57192
State FINISHED
Status VWARNING
PID:21292 Send msg Status -= WARNING Ensure that

collection service is up and running. Please refer to
collections log files for erroriwarning details

Detail Message

Log File E:\HP-SHRAPMDBMogitransform.log

bindcollection_audit -step reconcil -type WLSTransaction -category
WLSSPLRPT_METRICS

Max Retries 8640

Command

Remaining Retries 8840
Max Execution Time

(Mins)

Start Time May @, 2011 9:45:21 AM
End Time May 9, 2011 9:45:43 AM

QK

&0

In the alert details window, you can view the detailed error message, the command that
was run when the error occurred, remaining and maximum number of retries, maximum
execution time, and start and end time. If the job step continues to fail until the maximum
number of retries is reached, the status of the stream will remain as error and will no
longer be active. During the retry phase, if the maximum execution time is exceeded, the
status of the stream changes to MAX_EXEC_TIME_EXCEEDED and will no longer be
active. In this situation, the End Time will be displayed as NULL.

The alert details window does not appear for those alerts that are caused by maximum
execution time exceeded. You cannot click the Step Name column for these alerts to
open the details window. For more information on these alerts, check the Data
Processing page.

Orchestration Alerts

Symptom Orchestration Alert —- ERROR (Max Exec Time Exceeded)

Description On the Data Process Status page of the Administration Console, the

Step Status column displays the _ indicator for a particular
job step. Checking the status of the job step shows the MAX_EXEC _
TIME_EXCEEDED alert.

Resolution This alertis generated when the job step fails to complete executing
within the defined execution time frame. To troubleshoot this type of
error, perform the following steps:

1. On the Data Process Status page, click the job step icon in the
diagram to open a detailed message box about that job step.
2. Note the Process ID (PID) of the job step.

3. Browse to the %PMDB_HOME%\1og (Windows), $PMDB_HOME/log
(Linux) folder and open the dw_abclauncher.log file.

4. Search for the PID in the log file.
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5. Note the operating system PID of the job step. For example, an
entry in the log file might look like:

2010-11-23 02:50:12,522 INFO
[com.hp.bto.dw.common.log.DwLog] - Started step
'DatalLoad _Oracle_DiskSort' of stream 'Database_
Oracle@Facts_DiskSort' with Process ID = 119615
[PID:35408]

In this example, the PID for the job step is 35408.
6. Validate this operating system PID with an operating system utility
to check whether the process is running or not. For example, you

can check for the process in the Processes tab of the Windows
Task Manager window.

7. Ifthe process is listed as active in the Windows Task Manager,
perform any of the following steps:

m Wait for the job step to complete.

m If the job step execution does not complete after a day or
two or if there is a problem with the job step corresponding
to the PID according to the log file, end the process using
the operating system utility and contact HPE Support for
assistance.

8. Ifthe process is notlisted in the operating system utility, wait for
the workflow framework to rerun the job step. If the status
continues to show Error, contact HPE Support.

Symptom Orchestration Alert —- ERROR (Max Retries Exceeded)

Description On the Data Process Status page of the Administration Console, the

Step Status column displays the _ indicator for a particular
job step. Checking the status of the job step shows the ERROR alert.

Resolution This alertis generated when the job step failed to complete executing
because of an error. To troubleshoot this type of error, perform the
following steps:

1. On the Data Process Status page, click the job step icon in the
diagram to open a detailed message box about that job step.
2. Note the Max Retries and Remaining Retries fields.

3. Ifthe Remaining Retries is zero, perform the following steps to
abort the job stream:
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a. Click Start > Run. The Run dialog box appears.

b. Type ecmd in the Open field, and then press ENTER. The
Command Prompt window appears.

c. Type the following command to abort the job stream:
abcBatchControl -abort -streamId <stream name>
In this instance, <stream name> is the name of the job stream.

Symptom Orchestration Stream — Stage Always in Warning State

Description Status of stage step in Orchestration stream is always in warning state.
This occurs when the stage moves CSV files to %PMDB _
HOME%/stage/failed _to_stage (Windows), $PMDB_
HOME/stage/failed_to_stage (Linux)if it encounters any error due
to wrong data.

Resolution = When you see stage step in WARNING state, correct the data in the
CSV files manually and put them back to %PMDB _
HOME%/stage/failed _to_stage (Windows) ,$PMDB
HOME/stage/failed_to_stage (Linux) so that data is moved during
next run.

Symptom Job Streams not Loading or Running

Description After installing the content packs and configuring HPE OBR to collect
data, you notice that the Data Processing page of the Administration
Console does not display any active streams. The job streams are not
loading or running.

Resolution Ensure thatthe HPE_PMDB_Platform_Timer service is running.

Understanding Service Alerts

The Service Status pane on the Home page shows the @ icon for the HPE OBR service
status. This status indicates that the services are currently not running.

Figure 5: Service Status Pane on the Home Page
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Services Status
HPE PMDOB Platform Collection

HEE PFMDE Platform [k

HPE PMDE Platform DB | ogger
HEFE PMDEBE Platform Timer

HPE PMDOE Platform PostgreSQL
HFE PMDB Flatform Orchestration
HPFE PMDE Platform MRT ETL

POCOOLLLO

To investigate the problem further, you must check the Services page, where you can
get the detailed information of the status of each HPE OBR service.

Figure 6: Services Page in the Administration Console

| Service Name | Description
HPE PMDB Platform Collettion PMDB Collection Framework Service
HPE PMDE Pilatform M HPE Operations Bridge Reporter Internal Menitoring Framewerk
HPE PMDE Platform DE Logger Does IM logging by using Message Broker Service
HPE PMDE Platform Timer HPE OBR Timer Service to schedule data store jobs.
HPE PMDE Pilatform PostgreS0L Postgres Database Running
HPE PMDE Pilatform Orchestration HPE OBR Orchestration Service to schedule data stream jobs.
HPE PMOE Platform MRT ETL HPE OBR NRT Service to schedule data stream jobs.

In case of Error/Warning status against the HP PMDB Platform Collection, ensure
adequate free disk space on the drive where HPE OBR is installed (at least 15% free
space of total disk space).

If any of the service listed in the Figure 6 shows error, restart the service using the
Start/Stop link or the Windows Service panel. In case you have trouble restarting the
service or in case the service goes down frequently, contact HPE Support.

Understanding Database Alerts

Using the home page of the Administration Console, you can monitor the status of the
HPE OBR database connection. In the event of any problems, appropriate alerts are
displayed in the following section of the home page:

« Connectivity Status: This pane displays the status of the Vertica database
connection. In case the connection to the database cannot be established, the ©
status icon is displayed.

This section explains how to troubleshoot database-related alerts.
Database Alerts

Symptom Database Connection Failure
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Description The Connectivity Status pane on the home page of the Administration
Console shows the @ icon for the database.

Resolution @ Restart the Vertica database service from the services window.

Note: If Vertica is installed on a remote system, you must restart
Vertica database service on the remote system. The name of the
Vertica service might be different from the one mentioned in the
steps as it depends on the name that was defined when the service
was first created in the remote system.

Administrator Console Other Issues

Symptom Clicking the Next Button on the Post-Installation Wizard has no
Effect

Description The post-installation wizard does not respond when you click Next
after creating database.

Resolution Click F5, and then click Next again.

Symptom HPE OBR Server and Remote Collector Unable to Communicate
Across Networks

Description When the HPE OBR server and the Remote Collector are hosted on
different networks, they are unable to communicate with each other.

Resolution Ensure that the outbound connections from both networks are open
and inbound connection is restricted to a single port that the
communication broker must listen to. Perform the following steps on
the HPE OBR server and the Remote Collector to enable
communication across networks:

On the HPE OBR Remote Collector:

1. From the Command Line Interface (CLI), run the following
command:
ovconfchg -edit

2. Add the following lines:
[bbc.cb]
SERVER_PORT=<port_no>
where, port_no is the port open for communication.
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3. Restart the bbc service by running the following command:
ovc -restart

On the HPE OBR server:

1. From the Command Line Interface (CLI), run the following
command:
ovconfchg -edit

2. Add the following lines:
bbc.cb.ports]

PORTS=<server_FQDN-1:port_no>;=<server_FQDN-
2:port_no>

where, server_FQDN is the HPE OBR Remote Collector’s
Fully Qualified Domain Name (FQDN) and port_no is the port
open for communication. The port number must be the same
as that configured on the HPE OBR Remote Collector. You
can configure multiple collectors this way with different port
numbers for different HPE OBR servers.

3. Restart the bbc service by running the following command:
ovc -restart

After performing the above steps on both the HPE OBR server and the
HPE OBR Remote Collector, configure the HPE OBR Collector and
add it through the Administration Console. For more information, see
the HPE Operations Bridge Reporter Interactive Installation Guide.

Note: Proxy configuration is not required if at least one port is open
for inbound communication. Otherwise, you must configure reverse
channel proxy (RCP). For more information, refer the whitepaper
Configuring outbound-only communication with HP OpenView
Operations for UNIX 8.

Symptom Content Pack Installation Hangs

Description When installing content packs from Administration Console >
Administration > Deployment Manager, the installation does not
progress and spikes CPU utilization of the system.

Resolution If the content pack installation hangs, locate the datapipe _manager
system process and terminate it. The Administration Console >
Administration > Deployment Manager will report that content pack
installation had failed. Now, uninstall the content pack and begin
installation again.
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Symptom HPE OBR Administration Console reports Connectivity Issues
with Postgres Database

Description The Postgres audit measure table is accumulated with millions of
records that are not cleaned periodically. HPE OBR Administration
Console becomes unresponsive and does not allow monitoring of the
job streams details.

Resolution To resolve this problem, perform the following steps:

1. Log on to Postgres database using PgAdmin.
2. Execute the following SQL statement on weekly basis.

DELETE from audit_measure where md_process_id not in
(select md_process_id from job_stream_step_rt)

Symptom SQL Anywhere 12 Server Process Crashes

Description The BOE120SQLAW service goes down after trying to insert the
‘LONG’ data into one of the auditing table columns and SAP
BusinessObjects Bl Launch pad reports are not accessible.

Resolution Perform the following steps to resolve this problem:
Linux:

1. Log on to the HPE OBR system as root user.
2. Run the following commands in the prompt:
e su - SHRBOADMIN

e source $BOBJEDIR/setup/env.sh
m cd $BOBJEDIR/SQLAW/Bin
m dbisqlc

3. Log on to the SQL Anywhere AUDIT database with the
following credentials:

User ID: HPE OBR

Password: <password>

DB name: <HOSTNAME>BOE120 AUDIT

Server: <HOSTNAME>BOE120_ HPE OBR

where HOSTNAME is the system name where HPE OBR is
installed
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4. Execute the following query.
ALTER TABLE AUDIT_DETAIL ALTER Detail Text long
NVARCHAR

Windows:

1. Log onto the HPE OBR system.
2. Run the following command in the prompt:
dbisql

3. Log on to the SQL Anywhere AUDIT database with the
following credentials:

User ID: <HOSTNAME> (For example: iwfvm@e310)
Password: <password>

DB name: BOE120 AUDIT

Server: BOE120SQLAW_<hostname> (For example:
BOE120SQLAW_iwfvmoe310)

4. Execute the following query.
ALTER TABLE AUDIT_DETAIL ALTER Detail Text long
NVARCHAR

Symptom SAP BOBJ Tomcat Status is Down

Description The Connectivity Status section in Administration Console displays the
SAP BOBJ Tomcat status as Down while the Tomcat service is
actually running on the SAP BusinessObjects system.

Resolution Restartthe SAP BOBJ Tomcat service on the SAP BusinessObjects
system.

Symptom Failed to save time zone information in database

Description After completing the configuration of the remote Vertica database,
while verifying the configuration you may get the following error:

“Failed to save time zone information in database”

Resolution To resolve this problem, perform the following steps:

1. Connect to Vertica database using the dbisq| tool.
2. Execute the following query:

For GMT : insert into SHR_CONFIG(shr_key,shr_value)
VALUES ('shr.time.zone','GMT');

ForLocal: insert into SHR_CONFIG(shr_key,shr_value)

HPE Operations Bridge Reporter (10.00) Page 58 of 147



Troubleshooting Guide
Chapter 4: Troubleshooting Administration Console Issues

VALUES ('shr.time.zone', local);

Symptom Auto discover does not update the FQDN of Profile database

Description During the data source configuration with BSM, on clicking Discover

Database the hostname of Profile database does not get updated with
FQDN .

Resolution = While performing the data source configuration for the Management

database, ensure that you have typed a fully qualified domain name for
the hostname.

For more information on Management Database data source
configuration, see HPE Operations Bridge Reporter Configuration
Guide.
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Chapter 5: Troubleshooting Reporting Issues

HPE OBR provides an interactive user interface—the SAP BusinessObjects Bl Launch
pad interface that runs on your browser—to view the available reports. The reports are

generated by running a query on the underlying data. At times, if the data is missing or

there is a problem with SAP BusinessObjects, the report might not display any data.

This section of the guide covers the possible problems that lead to missing data in the
reports and how you can troubleshoot them.

SAP BusinessObjects Errors

This section covers some of the common errors related to SAP BusinessObjects
encountered in HPE OBR and the steps to troubleshoot them. These errors might
prevent the reports from opening or showing data.

In addition to these errors, SAP BusinessObjects provides a detailed list of errors for
Web Intelligence reports at the following URL,
http://help.sap.com/businessobject/product_guides/errors/12/0/en/html/.

Symptom  SAP BusinessObjects Central Management Console Error

Descriptio When trying to access the SAP BusinessObjects Central Management
n Console, the following error message appears:

Error: Server <server name> not found or server may be down
null

Resolution This error occurs when the specified port 6400 is locked by another
web service.

Symptom  SAP BusinessObjects Bl Launch pad Log in Error

Descriptio On the SAP BusinessObjects Launch pad log on screen, type the user
n credentials and click Log On. The following error message appears:

Logon denied: Your system does not allow the use of this
application

This error occurs due to any one of the following issues:
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1. HPE OBR license expiry
2. Poor BusinessObjects services
3. BusinessObjects crashes

Resolutio  The user can perform one of the following:

n 1. User can check for the license validity.

2. Administrator can log on to CMC/CCM and check for the status
of servers if they are up and running.

Note: CMC is available for both Windows and Linux platforms
whereas CCM is available only on Windows platform.

Perform the following steps through CMC:
1. Click Start and type Central Management Console in
Search. The Central Management Console page appears.
OR
Log on to CMC from the following url:
https://<HPE OBR_System FQDN>:8443/CMC

2. Enter the Username and Password and click Log On. The
CMC window opens.

3. Click Servers, under Organize. The server window appears.
4. Note the servers which are disabled under Server Name.
5. Right-click the disabled server, then click Enable Server.

Note: This step has to be performed on all disabled
servers.

Perform the following steps through CCM:
You can verify this from the HPE OBR machine.
1. Click Start and type Central Management Console in Search.
The Central Management Console page opens.

2. Select Server Intelligent Agent and click Manage Server icon
on the tool bar.

3. Enter the Admin Username and Password and click Connect.

4. Check for the current status of BusinessObjects servers from the
newly opened window.

5. Enable the down/disable servers if any and start the server.
To check the status of the license, see the Licensing page in the

HPE Operations Bridge Reporter (10.00) Page 61 of 147



Troubleshooting Guide
Chapter 5: Troubleshooting Reporting Issues

Administration Console. If the license has expired, you must
renew the license, apply for a permanent license, or contact
HPE Support for assistance. For more information, see the
Managing licenses section in the HPE Operations Bridge
Reporter Administration Guide.

Symptom Report Timeout Error

Description While performing an action on an open report, such as changing the
prompts, selecting the filters, or accessing the report tabs, the following
error message appears:

An error has occurred: A timeout error has occurred

Resolution | This error occurs when a Web Intelligence session is opened and kept
idle for a long time. To resolve this, click Document List and reopen the
required report.

Symptom Internal Error

Description While opening a report, one of the following error messages appear:

Prompts

i An internal error occured while
calling "answerPrompts’ AP (Error: ERR_WIS_30270)

Prompts
An internal error occured while

@ calling "getDocumentinfesMDP AP (Error
ERR_WIS_30270)
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Prompts
i An internal error occured while
calling "answerPrompts’ APl (Error: ERR_WIS_30270)

Resolution This error occurs because the utilization of the system resources as
well as SAP BusinessObjects internal services was very high at that
particular moment when the Web Intelligence report was accessed.
The SAP BusinessObjects services were in a waiting state for that
moment when the report was accessed. To resolve this issue, click OK
in the message box and refresh the report.

Symptom Server Memory is full - SAP BusinessObjects Reports Error

Description SAP BusinessObjects Reports displays a error message server
memory is full.

Resolution To resolve this issue the memory must be increased manually. Follow
these steps:

1. Log on to CMC from the following url:
https://<HPE OBR_System FQDN>:8443/CMC
2. From the drop-down list select Servers.

©w

Click on Servers List on the left pane.

-

Select AdaptiveProcessServer and right-click and click Stop
Server.

Right-click AdaptiveProcessServer and click Select Services.
Move the services listed to the left pane to Add Services. Click OK.
Right-click AdaptiveProcessServer and click Properties.

© N o O

In the Command Line Parameters replace Xmx2g with Xmx4g. Click
Save & Close.

©

Right-click AdaptiveProcessServer and click Start Server.

10. Select WeblintelligenceProcessingServer and right-click and
click Stop Server.

11. Right-click WeblntelligenceProcessingServer and click
Properties.

12. Edit the parameters as shown in the following image:
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13.

Web Intelligence Core Sarvice

Use Configuration Template

Timeout Before Recycling (seconds): 1200
Idle Document Timeout (seconds): 300
Server Polling Interval (seconds): 120
Maximum Documents per User: 5
Maximum Documents Before Recycling: 50

¥ Allow Document Map Maximum Size Errors
Idle Connection Timeout (minutes): 20

M 2wirmi i Connoetinne A

Enable Memory Analysis

Mermory Lower Threshold (MB): 5500
Mermory Upper Thresheld (MB): 7000
Memory Maximum Thresheld (MB): 6500

Enable APS Service Monitoring
Retry Count on APS Service Ping Failure: 3
APS Service Menitoring Thread Period: 300
Enable Current Activity Logs

| Restore System Defaults
Set Configuration Template

Web Intelligence Processing Service

Use Configuration Template

«| Enable use of HTTP URL

Click Save & Close.

Select WeblntelligenceProcessingServer, right-click and click
Start Server.

Symptom Server is busy - SAP BusinessObjects Reports Error

Description SAP BusinessObjects Reports displays a error message server is
busy.

Resolution To resolve this issue the memory must be increased manually. Follow
these steps:

1.

Log on to CMC from the following url:
https://<HPE OBR_System FQDN>:8443/CMC
From the drop-down list select Servers.

Click on Servers List on the left pane.

Select WeblntelligenceProcessingServer and right-click and
click Stop Server.

Right-click WeblntelligenceProcessingServer and click
Properties.
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6.

7.

Clear Enable Memory Analysis and Enable APS Service
Monitoring as shown in the following image:

Web Intalligence Core Sarvice

Use Cenfiguration Template

Timeout Before Recycling (seconds): 1200
Idle Document Timeout (seconds): 300
Server Polling Interval (seconds): 120
Maximum Documents per User: 5
Maximurm Documents Before Recycling: 50

¢ Allow Document Map Maximum Size Errors
Idle Connection Timeout [minutes): 20

M avimiim Connactnne: [

Enable Memory Analysis

Mermory Lower Threshold (MB): 6500

Memory Upper Threshold (MB): 7000

Memory Maximum Thresheld (MB): 6500
Enable APS Service Monitoring

Retry Count on APS Service Ping Failure: 3

APS Service Monitoring Thread Period: 300

Enable Current Activity Logs

| Restore System Defaults
Set Configuration Template

Web Intelligence Frocessing Service

Use Configuration Template

« Enable use of HTTP URL

Click Save & Close.

Select WeblIntelligenceProcessingServer, right-click and click
Start Server.

Symptom Error: lllegal access to viewer please use a valid url

Description This error appears while a new report is opened or a existing reportis
refreshed. This is because the web intelligence server and connecting
server is in failed state. To resolve this issue perform any one of the
following resolution.

Resolution Follow these steps to overcome this issue:

1 1.

Click Start and type Central Management Console in Search.
The Central Management Console page appears.

Enter the Username and Password and click Log On.
Click Servers, under Organize. The server window opens.
Click Servers List from the left pane.
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5. Right-click on OBR.WeblintelligenceProcessingServer and click
Properties. The properties page appears.

6. In Web Intelligence Core Service, clear Enable Memory
Analysis.

7. Click Save & Close.
8. Startthe SAP BusinessObjects service as follows:
On Windows:

» Go to Start > Run, type services.msc.
« Right-click on Business Objects Webserver and click Stop.
« Right-click on Business Objects Webserver and click Start

On Linux:
o Go to the location /etc/init.d.

o Runthe command service SAPBOBJEnterpriseXI4@ stop
o Runthe command service SAPBOBJEnterpriseXI40 start

Resolution 1. Go to the following location:
2 /opt/HP/BSM/BOE4/setup/
2. Run the following command to verify the size of boconfig.cfg:
ls -sh

3. Ifthe size of boconfig.cfgis 0 KB, copy the boconfig.cfg file
from working system to the same location OR Contact HPE
Support.

4. Log on to CMC from the following url:

https://<HPE OBR_System FQDN>:8443/CMC

Enter the Username and Password and click Log On.
Click Servers, under Organize. The server window opens.
Click Servers List from the left pane.

© N o O

Right-click on OBR.WeblintelligenceProcessingServer and click
Restart Server.

9. Right-click on OBR.ConnectionServer and click Restart Server.
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Enabling Bl Launch Pad to Authenticate Users

Steps to enable Bl Launch pad to authenticate through LDAP or Active Directory or
Enterprise

Steps 1. Create a file BIlaunchpad.properties in %PMDB_
HOME%\BOWebServer\webapps\BOE\WEB-INF\config\custom with
the following entries:

a. authentication.visible
b. authentication.default
2. Setthe value of the <authentication.visible> parameterto true.
3. Setthe value of the <authentication.default> parameter as follows:

Authentication Through Value

LDAP secLDAP
ActiveDirectory secWinAD
Enterprise secEnterprise

4. Save and close the file.
5. Restart the web application server.

Bl Launch Pad Landing Page Alerts

Solution To enable Bl launch pad landing page Alerts, as shown in the following

image:
[iome | cosurers |
S ¥
~
- No recently run documents: {/>
3
)
Steps For information to set the Alerts, see How to set alerts for Watchlist in Bl

4.0 document located at URL: hitps://softwaresupport.hp.com/
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Also, for information on metrics available to all servers, see Explanation of
Server Monitoring Metrics for SAP BusinessObjects Business Intelligence
4.0 document located at URL: hitps://softwaresupport.hp.com/

Reports Issues

Sympto No Data Retrieved for Reports
m

Descrip After opening a report and specifying the prompts, a window appears with
tion amessage No data to retrieve in the following Queries. For
example, consider a WebLogic report for a EJB Dailyreport.

Resolut This problem could be due to any one of the following issue:

ion ,
1. Incorrect prompt selection

2. No data available for the selected dimension
3. ETL issues

4. Aggregation issues

5. Source issue/not monitoring the nodes

The following flow chart provides the steps you must follow to troubleshoot
the possible causes:
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Y
No Data collected

START

Report with Mo Data
Identify ETL and
DWH Streams

Check the DWH
Stream for the
REpo

Was the stream
launched in last 24
hours

YES

Collection Issues DWH lssue

¥

¥
Mo Data
tailable in Chadk for emors at 1
Stage table load step

Check the ETL Stream Chedk for ermars at
Status for Fourty aggregation A
corresponding DWH stes
Stream

Data Source Is5ues

from the data
SOUIce

!

Chedk for the
collection status in
Admin Ul

D (Datasource)
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Chedk for ermars at
daily aggregation
step

ETL Issues
¥
Check for errors in z
COLLECT step
check for errors in =
TRANSFORM step
check for errors in
RECOMNCILE step
Check for errors in
STAGE step

If test connection failed then the reachability
to the data source needs to be verified.
Check if all the required services on the
source are running. See the
"Troubleshooting Data Source Issues" on
page 89 section.

There is no data available on the source.
See the"Troubleshooting Data Source
Issues" on page 89 section.
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C Symptom:

(Collect) The COLLECT step for the stream shows
ERROR (Red icon) and files are piling up in
the {PMDB_HOME}/collect folder.

Contact HP Support if this is your scenario.
There are no known cases when this should

fail.
T Symptom:
(Transform) The TRANSFORM step for the stream

shows ERROR (Red icon) and relevant files
are piling up in the {PMDB_HOME}/failed_
to_tranform folder.

Contact HP Support if this is your scenario.
There are no known cases when this should

fail.
R Symptom:
(Reconcile) The RECONCILE step for the stream shows

ERROR (Red icon) and relevant files are
piling up in the {PMDB_HOME }/failed_to_
reconcile folder.

Resolution:

See "Troubleshooting Data Source Issues”
on page 89 section.

S Symptom1:

(Stage) The STAGE step for the stream shows
ERROR (Red icon). Drill down detail, the
following message is displayed "Database
server not found". Also, relevant files are
piling up in the {PMDB_HOME } /stage folder.
Resolution:

HPE Operations Bridge Reporter (10.00)

1. This can be due to temporary loss of
connection to database and the next
run of the step takes care of
reprocessing data.
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2. Ifthe files are getting piled up in
stage directory, check connectivity to
the database. See the
"Understanding Database Alerts" on
page 54 section.

Symptom2:

The STAGE step for the stream shows
ERROR (Red icon). Drill down detail, the
following message is displayed You have
run out of space in pmdb_user_main
DBSpace. Also, files are piling up in the
{PMDB_HOME}/stage folder.

Resolution:

1. Increase the disk space if the drive is
running full.

2. Increase the pmdb_user_main
database space manually and start
the HPE_PMBD Internal_
Monitoring service in case the
service is stopped or disabled.

Symptom3:

The STAGE step for the stream shows
ERROR (Red icon). Drill down detail, the
following message is displayed
Insufficient buffers for.Also, files
piling up in the {PMDB_HOME } /stage folder.

This error occurs because the temporary
cache is not adequately provisioned.
Resolution:

You can ignore this error if it occurs
occasionally. If it occurs frequently, consider
the following options:

1. See the HPE Operations Bridge
Reporter Performance, Sizing, and
Tuning Guide for temporary cache
configurations.

2. Reduce the number of concurrent
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jobs you launch. See the HPE
Operations Bridge Reporter Online
Help for Administrators.

L,A, S Symptom1:
(Load, Aggregate, SQL The LOAD/AGGREGATE/EXEC_PROC
Executor) step for the stream shows ERROR (Red

icon). Drill down detail, the Database
server not found message is displayed.

Resolution:

1. This can be due to temporary loss of
connection to database; the next run
of the step should resolve the
reprocessing the data.

Symptom2:

The LOAD/AGGREGATE/EXEC_PROC
step for the stream shows ERROR (Red
icon). Drill down detail, the You have run
out of space in pmdb_user_main
DBSpace message is displayed.

Resolution:

1. Increase the disk space if the drive is
running full.

2. Increase the pmdb_user_main
database space manually and start
the HPE_PMBD _Internal_
Monitoring service if the service is
stopped or disabled.

Symptom3:

The LOAD/AGGREGATE/EXEC_PROC
step for the stream shows ERROR (Red
icon). Upon drilling down, the
Insufficient buffers messageis
displayed and data is stuck in source tables.

This error occurs because the temp cache is
not adequately provisioned.
Resolution:
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You can ignore this error if it occurs
occasionally. If it occurs frequently, consider
the following options:

1. See the HPE QOperations Bridge
Reporter Performance, Sizing, and
Tuning Guide for temporary cache
configurations.

2. Reduce the number of concurrent
jobs you launch. See the HPE
Operations Bridge Reporter
Administration Guide.

F (Schedule Frequency) To check the Collection Status and the
Schedule Frequency, log on to the
Administrator Console, select Collection
Configuration. Select a data source to see
the Collection Status and the Schedule
Frequency.

I See the "Unable to Refresh a Report" on the

. next page or "Generating Reports to Stream
(dentify Streams) Mapping Information" on page 129 section to
identify the stream associated with the
report.

Symptom Bl Launch pad reports session expire message

Description While working on the Bl Launch pad reports the session expire
message pop-up appears as shown in the following image:

Session Timeout Warming

Your user session will expire in 5 minutefs), Would you like to continue your user session or
Iog off?

Continue I Log Off I

Resolution  Follow these steps increase the launch pad session timeout pages:

1. Stop the Tomcat server:

On Windows: Go to Start > Run, type services.msc, right-click
Business Objects Webserver service and click Stop.
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On Linux: Go to the location
/opt/HP/BSM/PMDB/BOWebServer/bin and run the command:
./shutdown.sh

2. On Windows: Go to the location %PMDB_
HOME%\BOWebServer\webapps\BOE\WEB-INF.

On Linux: Go to the location
/opt/HP/BSM/PMDB/BOWebServer/webapps/BOE/WEB-INF.

3. Open the web.xml and locate the following:
<session-config>
<session-timeout>20</session-timeout>
</session-config>

4. Edit the session-timeout value for more than 20 minutes.
For example: to set the session timeout to 60 minutes.

<session-config>
<session-timeout>60</session-timeout>
</session-config>

5. Start the Tomcat server:

On Windows: Go to Start > Run, type services.msc, right-click
Business Objects Webserver service and click Start.

On Linux: Go to the location
/opt/HP/BSM/PMDB/BOWebServer/bin and run the command:
./startup.sh

Symptom Unable to Refresh a Report

Description You cannot refresh a report to display updated information because the
cascading prompt value in the Prompts dialog box is missing.

Resolution This problem occurs because of missing data in the dimension tables
for a query. To troubleshoot this problem, perform the following steps:

Note: The following steps are performed using the WebLogic EJB
Cache Hit report as an example but you can perform these steps
for any report.

1. Check the dimension table for data pertaining the query:
a. Click Cancel in the Prompts window.
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b. On the report toolbar, click Edit.

c. Ifa Warning - Security message box appears, click Yes. The
report opens in Edit mode.

d. On the toolbar, click Edit Query.

e. Atthe bottom of the report, click EJB Daily, and click SQL in
the Report toolbar. The SQL Viewer dialog box opens, which
displays the SQL for that query. Note that EJB Daily is used as
an example here. For any other report, you must edit the
respective query.

f. Identify the dimension table from which the EJB name is
fetched. In this example, the dimension table is K_CI_JEE_
Server.

To identify the table perform the following:

1. Log on to the Administration console, click Internal Monitoring >
Content Health Status. The Content Health Summary is
displayed.

2. Click the Reports Impacted link. You can check the Affected
Reports on the right hand pane.

For more information, see HPE Operations Bridge Reporter
Administrator Guide.

Symptom Report Appears Blank after Refreshing

Description After opening a report and applying the necessary prompts, the report
does not display any data.

Resolution The report appears blank due to any one of the following issue:

1. Incorrect entry of measurable object (memory util, cpu util).

2. No data is displayed if the report is generated for the first
section in a section based report.

The section is displayed in alphabetical order by default.
The report does not display any data because you might not have
selected the time-drill filters for the report.
To resolve this problem, perform the following:
« Set the time-drill filters on the Report Filter toolbar, if they are
available for the report.

« If context-based filters are available on the Report Filter toolbar,
select the appropriate value from the drop-down list.
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« Reports might appear blank because of issues in the database such
as missing business keys, table not loading, and so on. To
investigate such errors, contact HP Support.

Symptom

Description

Missing Data for Specific Time Period

A selected report displays data for a particular time period even when

drilled down to the day level. However, when the time period is
changed to different week, the report does not display any data.

Resolution
one

Symptom

1 OPERATIONS BRIDGE REPORTER

Application Server - WebLogic

o

Report Period: 11/2/15 - 2/1/16

WebLogic Top N Summary
f‘l'l23'0567B9‘\0‘\1'\113'\4'\516‘\7181‘?2021222’524252627282‘7303'\'

Business Service(s) Al

Business View(s) / Group(s) All

shift Default_shift Location All

Top N Servers by JVM Memory Utilization (%)

JeeServer Name Node Name

Top N Servers by Execute Queue Wait Count

JeeServer Name Node Name

Top N Servers by JDBC Delay Time

JeeServer Name Node Name

Top N Servers by EJB Wait Rate

JeeServer Name Node Name

of the following issues:

Average JVM Memory Utilization (%)

Average
Average Wait Count  Throughput Rate
(Per Sed)

Average Delay
Time (Milli
Seconds)

Average
Throughput Rate
(Per SeQ)

Average Wait Rate

Per Mim) Average Cache Hit (%)

1. ETL issues - SeeReports Issues

2. Aggregation - See Reports Issues

This problem occurs because of missing data which could be due to

3. No metric collection for selected time period - Check the
retention period for the selected time period.

4. No particular SPI.

Unable to export a report in csv format from SAP
BusinessObjects Bl Launch pad

Description Unable to export a report in csv format from SAP BusinessObjects
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Bl Launch pad this is because the binary output size has reached the
maximum limit.

Resolution To resolve this issue, follow these steps:

1. Log on to Central Management Console (CMC) as Administrator
with Enterprise authentication mode from the follwoing link:
http://<HPE OBR_System_FQDN>:8080/CMC
OR
https://<HPE OBR_System_FQDN>:8443/CMC

where, <HPE OBR_System_FQDN> is the fully qualified domain
name of the HPE OBR system.

2. Click Servers.
3. From the Service Categories, click Web Intelligence.

4. Double-click on Web Intelligence Processing Server. The
Properties page appears.

5. Increase the Binary Stream Maximum Size (Default value=50
MB; Maximum value = 65535 MB).

6. Click on Save and close
7. Selectthe Web Intelligence Processing Server and click the

Restart servericon - to restart the Web Intelligence server.

Symptom No Data in Smart Plugin (SPI) Data Source Reports

Description This symptom is applicable to Microsoft
SQLServer/Oracle/WebSphere/WebLogic reports that do not display
any data.

Resolution This problem occurs because of data logging issue with
HP Performance Agent when both HP Operations Agent and HP
Performance Agent are installed in your environment. The table below
consists of the data sources that the content pack uses. Due to
improper summarization of metric ID and value ID, these reports fail to
show data.

To resolve this, HP Operations Agent must be used for data logging
instead of HP Performance Agent.
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Content Pack Name Data Sources (HP — Performance Agent)
Oracle DBSPI_ORA_REPORT; DBSPI_ORA_GRAPH
MS SQL DBSPI_MSS_REPORT; DBSPI_MSS_GRAPH
WebLogic WBSSPI_METRICS; WBSSPI_RPT_METRICS
WebSphere WLSSPI_METRICS ; WLSSPI_RPT_METRICS
Active Directory ADSPI

Exchange 2007 EX2007_DATA

Exchange 2010 EXSPI_DATA

For more information and the Resolution steps for SQL Server and
Oracle reports, see the Troubleshooting Data Logging with

HP Performance Agent section of the SPI for Databases 12.04
Installation and Configuration Guide.

For more information and the Resolution steps for WebLogic reports,
see the Integrating WebLogic SPI with HP Performance Agent section
of the SPI for WebLogic Application Server 7.04 Installation and
Configuration Guide.

For more information and the Resolution steps for WebSphere reports,
see the Integrating WebSphere SPI with HP Performance Agent
section of the SPI for WebSphere Application Server 7.04 Installation
and Configuration Guide.

Symptom Tooltip not working in Firefox 10.0.3

Description Tooltip not working in Firefox 10.0.3

Resolution Upgrade the browser to a minor version like Firefox 10.0.6 or a major
version like Firefox 11.

Symptom Internet Explorer Hangs when Zoom Level is 90-95%

Description Internet Explorer Hangs when Zoom Level is 90-95%

Resolution You must set the zoom level of the reports to any number except

between 90-95%.

Symptom  Missing Input Controls Pane in Report
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Descriptio  After opening a report, user is unable to find input controls (wherever
n applicable).

DEeE-1S-®wlP2-=2-
[ % [Location Nare (allslues) v |

Web Intelligence -

[oole-

| [ Track - |3 Drill |~ |7 Filter Bar ﬁ Freeze - [ Outline |

@) 1 OPERATIONS BRIDGE REPORTER e

System Management Report Period: 11/2/15 - 2/1/18
System Exception by Group

Business Service(s) All
Business View(s)/ Group(s) All
Shift Default_Shift Location All

System Resource Utilization

ot iy e el b
Exceptions
AD_Physical_View 5827 8375 501 2919 501
2980 33808 20844 0 o
EUM_BSMR 3855 571 598 601 598
100 0 9.89% 0 0
J2EE_Deployment 2459 7436 599 3016 599
976 30,048 20,496 180 (o]
:’,ZI:E'DEDIW'“E"LB”SMSS 2459 7436 599 3018 599
976 30048 20496 180 0
MSSQL_BusinessView 1849 9222 503 3675 803
4 17,776 nos 0 (o]
MssQL_Deployment 9222 £03 3875 £03
s w6 016 0 )

l @ System Exception by Group

Resolution Perform the following:

1. Click the Input Control icon in the left pane to get the list of input
controls available for the report as shown below.

WebIntelligence ~ (D1 2= [E - | &S~ db | L~ = - |-f> o | @ || R Track + D0l - [ Filter Bar | [7] Freeze ajao.mme|
[ Input Controls ~ 3\ | i7 | Location Name (All values) ¥
Map Reset
lEE ~ Document Input controls (0}
=2 | _~_Report input controls (1)
(2 || Mede Name. 2 1 OPERATIONS BRIDGE REPORTER (2]
= ||# select (al)) N
4 beolindtpom System Management Report Period: 1/2/15 - 2/1/16
i B
@) iwf0041041.ind.hp.com Y 9
% wf0041043.ind.hp.com System Exception by Group
#) 1wf0041057.ind hp.com N .
Business Servi Al
) inf0089144ind.hp.com usiness Sent
) wF1085145.bn.hp.com Business View(s)/ Group(s) Al
@ w1088150.bbnhp.com shift Default_Shift Location Al
¥ wf1088151.bbn.hp.com System Resource Utilization
¥ wf1085152.bbn.hp.com - - T,
@ 1056153 Bonhpcom r— CPU Utilzation  Memory Utiization WY Swap Urilization  Memory Page out
%/Exceptions %/ Exceptions § %/ Exceptions  Rate / Exceptions
(¥ iwf1088154 hpswiabs.adapps.hp.com Exceptions
@ inf1088155 hpswlabs.adappshp.com AD_Physical_View 5827 8375 601 2919 601
¥ iwf1088156.ind.hp.com 2980 33,808 20,844 o o
¥ iwf1088158.bbn.hp.com EUM_BSMR 3855 571 598 601 598
¥ iwf1088152.bbn.hp.com 100 o 9,896 o ]
(¥ iwf1088160.ind.hp.com JZEE_Deployment 2459 7436 599 3038 599
(¥ wf1088161.bbn.hp.com 076 0068 20436 180 o
@ wf1085162.bbn.hp.com
JZEE_Deployment_Business
¥ 1wf1088163.bbn.hp.com View 259 7436 599 306 599
¥ wif1085164.bbn.hp.com 976 30,048 20496 180 0
24
] wf1083168 bbn.hp.com MSSQL_Businessview 849 9222 503 675 603
¥ iwf1085169.hpswiabs.adapps.hp.com
& 17,776 nos o 0
¥ 1wF1085204.ind hp.com
@) 1wf1083074nd.hp.com - MSSQL_Deployment 1849 9222 603 3675 603
& 17.776 1016 o 0
2 system Exception by Group
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Symptom Select/Unselect Input Control Data and then Drill Down from
Current Level give Improper Results

Description After opening a report, if you select/unselect input controls (wherever
applicable) and then drill down from the current level, you get improper
results.

Resolution If this issue occurs intermittently, perform the following steps:

1. Select/unselect desired values from input control.

2. Drill up to first level (for example, up to all years in out of the
box HPE OBR reports).

3. Drill down so that data syncs up properly with the selected
dimensions from input controls.

Symptom Only Drill Icon Appears when Date Range is Across Years

Description After refreshing a report for the selected dates which they span across
years, only the drill icon appears in the drill bar section of the report
with missing dates.

Resolution 1. When the report is refreshed for a selected date range that spans
across years as follows only drill icon appears:

[ OPERATIONS BRIDGE REPORTER o

Application Server - WebLogic Report Period:1/4/15 - 2/29/1

Servlet Performance Summary

P—
i i
——
Business Service(s) Al
Business View(s) / Group(s) Al

Shift Default_Shift Location Al

Node Name JeeServer Name

Servlet Request Rate and Response Time
Request Rate (Per Second) Execution Time (Milli Seconds)

Average Maximum Average Maximum

Servlet Name

2. Selecting the required Year in the analysis context (as displayed in
the following image) solves this issue and the report can be drilled
down/up for further analysis.
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‘?,' Location (All values) 'I2016 v l’k:nth (Al values) T

:I OPERATIONS BRIDGE REPORTER e
Application Server - WebLogic Report Period: 11/4/15 - 2/29/16
Servlet Performance Summary

123456789 10 1112 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29
Business Service(s) All
Business View(s) / Group(s) All

Shift Default_shift Location All

Node Name JeeServer Name

Servlet Request Rate and Response Time
Request Rate (Per Second) Execution Time (Milli Seconds)

Serviet Name ~ _
Average Maximun m Average Maximum

Symptom Refreshing a Single-Day Data Report Returns Inaccurate Data

Description When the reportis refreshed for a single day, the report shows data
only for the first hour instead of all 24 hours

Resolution 1. When a report is refreshed, for example: for 1-Aug-2012, the report
shows data only for the first hour.

2. To fetch data for all 24 hours of a single day, refresh the report with
Select Start Date as 1-Aug-2012 and Select End Date as 2-Aug-
2012.

Now data for all 24 hours of 1-Aug-2012 is shown.

Symptom SAP BusinessObjects Bl Launch pad Page Timeout Error
Description SAP BusinessObjects Bl Launch pad Page Timeout Error

Resolution The following steps will resolve the Launch pad page timeout error.

1. In the web.xml file, set the variables.
logontoken enable=false,

session-timeout=120 (You mustsetthese variables in all
web.xml files of installed applications; you can set session timeout
over 120 minutes too, but up to maximum 8 hours).

[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\CmcApp\WEB-INF

[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\InfoViewApp\WEB-INF

[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\InfoViewAppActions\WEB-INF
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[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\CmcAppActions\WEB-INF

[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\AnalyticalReporting\WEB-INF

[<Install DIR>Program Files (x86)\Business
Objects\Tomcat55\webapps\OpenDocument\WEB-INF

2. Add -failovertimeout 1 to the command line parameter of CMS for

CMC.
3. Log on to CMC server.

4. Right-click Central Management Server and append the

command line with the switch.

5. To add the switch, right-click Central Management Server.
6. Go to the command line, enter a space and append the switch.

Properties; XI315P3.Cer

1 0x

Properties

ity Server Name: 131 5p3, CentralManagementserver
Metrics ID, CUID: 721, AXaTDGUOOBBEFnYHjoRRCH
Audt Events Node: XI315P3 (XI315P3, Administrator)
Placeholders DesCription: gt Management Server
Existing Server Gro

\win32_x86\_boa_XI315P3.dbinfo"
usiness Objects/BusinessObjects Enterprise 12.0/logaing/"|-falovertimeout 1

Enterprise 12.0\

Common Settings

Request Port: Auto assign
Host Identfiers:

© Auto assign

Hostname

-autoboot -dbinfo "D:\Program Files\Business Objects\BusinessObjects Enterprise 12,0

-fg -restart -name X1315P3.cms -pidfile “D:\Program Fies\Business Objects\BusinessObjects
XI315P3.Ce pid"

0 Addrage () (108

@ Save & Close Cance
o -

LG Total: 30 object

Log on to Launch pad and wait for 121 min to get web session and

enterprise session timeout.

Symptom Unable to save a report to a file system (On Linux only)

Description The SAP BusinessObjects scheduling feature for reports from Launch
pad requires R package. This package is not installed by default.

Resolution To get the scheduled reporting output to a file system, follow these

steps:

1. Install and configure the R package (for example: rexec and rsh
client and servers) to the system where SAP BusinessObjects

componentis installed.
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2. Enable rsh for the SHRBOADMIN user.

Symptom  Setting the Sync Drill on Blocks

Descriptio After refreshing a report, when the reportis drill down to “Hour” level

n dimension, entire report is not in sync at the same dimension, such as
the first block on which drill was executed shows data at “Hour” level
but the remaining blocks shows data at “Day” level.

Resolutio  This problem occurs because preferences are not set for the drill option.
n Perform the follow steps to set them:

1. Go to Preferences in Launch pad:

=
Howlattpacard  Operations Bridge Reporter Welcome: Administrator | Applications ¥ || Preferences [ Help menu .

Home | Documents

~_My Recently Viewed Documents =0 unread messages in My Inbox ~ My Applications

2. Under Web Intelligence, from the Drill options section, select
Synchronize drill on report blocks as follows:

Preferences — Administrator

le Preferences Web Intelligence
General View
Change Enterprise Password ® HTML (no do
Locales and Time Zone applet (do
Desktop (Rich
PDF

ndows only, installation required) (installation required)

Analysis edition for OLAF

BI workspaces Modify (creating, editing and analyzing documents):
Crystal Reports of: 1 hed i the Go To list or My Applications shortcut.

wes enly, installation required) (installation required

Browse ...

When viewing a docurr
Use the doc it locale to format the data
® Use my preferred viewing locale to format the data

Drill options:
Promptawben drill reguices additional data
ronize drill on report blocks

TEETEST S SESTtOE

® On existing report

Select a priority for saving to MS Excel:
Pricritize the formatting of the documents
@ Prioritize easy data processing in Excel

3. Click OK, then logout and log on again to Launch pad. If the report
is drilled down to hourly level, even the other blocks will get
synchronized accordingly.

Symptom Some System Management Reports Fail in VMware vCenter
Deployment

Description When HPE OBR is logging data from VMware vCenter, some System
Management reports are empty or fail to generate.

Resolution When VMware vCenter is the data source for HPE OBR, only the
following System Management reports are populated:
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« SM Executive Summary

o SM System Availability Summary
o SM System Forecast Summary

o SM System Inventory

« SM Top and Bottom 5 Systems

« SM System Availability Detail

o SM System Availability

Symptom SPI Availability Report Show higher-than-expected “Unknown
Time”

Description HPE OBR sources the data from the respective classes such as
DBSPI_ORA_REPORT, EX2007_AVAILABILITY and soon. To
compute availability, a post-collection procedure populates the data in
the content packs (such as Exchange, WebLogic, WebSphere, Oracle,
and Microsoft SQL). The “Unknown Time” is marked when HPE OBR
has not received a valid data sample from the agent for a certain period
(5 minute sample in SR__ tables).

Resolution The issue can occur in the following scenarios.
Scenario 1:

If duplicates exist in the dimension table (such as K_CI_Oracle, K_CI_
Exchange_Server, and so on), then “Unknown Time” occurrence is
possible. In case of duplicates (say two instances), one Cl would be
old and the other new. The old Cl would not have logged data after the
new Cl entered the system. This duration of the old Cl is marked as
Unknown Time because no valid data is received from source.

Perform the following steps to resolve this issue:

1. If you have previous version of HPE OBR, upgrade it to the
latest version.

2. Use the Dimension Life Cycle Manager tool to delete the
duplicate Cls.

For more information on deleting duplicate Cls, see section Managing
Dimensions in the HPE Operations Bridge Reporter Administration
Guide.

Resolution Scenario 2:

If CODA is facing issues, data logged from Agents will not have the
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complete set of samples (12 samples per hour). This results in
unknown time showing up in HPE OBR reports. For example, although
the SPI policy for availability is configured to log data every 5 minutes,
the Agent fails to log the complete set of samples every 5 minutes.

To fix issues with missing data in CODA, log a case with HP Support
for the Agent module.

Resolution  Scenario 1:

If the SPI policies pertaining to availability are not configured to log the
data every 5 minutes, (and instead logging data for say every 10
minutes), then for an hour HPE OBR will have only 6 samples as
against 12 from Agent. This can report 50% unknown time.

To resolve this issue, configure the SPI policies to log availability data
every 5 minutes.

Note: Any other mode of logging will report erroneous availability and
also unknown time.

Symptom Errors when Creating or Modifying HPE OBR Reports

Description You notice errors which say the required permissions and manifest
attributes are missing. Or you encounter the following security
exception error when you try to modify the HPE OBR reports.

Aper oo Ernor il

Seecuritylk xceplion o

Mg ¢ oA Permrriern i fet! AR S
e i 5Ll I e S0ET ianialy Sonlitinpeas Brg e Endonie & ThinCederna e

Dotsly | | toroen ] [ Rkoad

These issues can occur when a higher version of the Java
Development Kit (JDK) is installed on the system. Or when the security
settings in Java are rigid and do not allow running applications that are
unsigned, self-signed (not signed by trusted authority), and when the
applications are missing permission attributes.

Resolution To resolve this problem, try the following options:

1. Verify that you have the Java Development Kit (JDK) version 1.6
installed on the system. Higher versions of JDK might cause
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compatibility issues.

2. Go to Control Panel > Java . The Java Control Panel window
appears.

3. Click the Security tab.

4. If your policies allow, lower the security setting by moving down
the slider to Medium.

5. Add the URL of the HPE OBR host system to the Exception Site
List.

a. Click Edit Site List. The Exception Site List pane appears.
b. Click Add.

c. Enterthe URL of the HPE OBR host system. (For example,
http://<hostname>:8080/AnalyticalReporting/. Click OK.

6. Click Apply.
7. Click OK.
8. Restart the browser.

Symptom Error Message Appears while Refreshing Audit Reports

Descripti  The following error message appears when you refresh audit reports by
on using browser's refresh button:

An error occurred while creating a sub-process in the
processing server.

Resolutio Importthe BOaudit.biar file on the SAP BusinessObjects system. The
n BOaudit.biar file is available in the following location:

o Windows: %PMDB_HOME%\contrib
o Linux: $PMDB_HOME/contrib

Use SAP BusinessObject's import utility to import the BOaudit.biar
file.

On Windows

Click Start and type Import Wizard in Search. The Import Wizard
Screen appears.

Click on Next to open source and destination screens.
To Deploy the BIAR file:

1. Choose Business Intelligence Archive Resource(BIAR) File as
Source.

HPE Operations Bridge Reporter (10.00) Page 86 of 147



Troubleshooting Guide
Chapter 5: Troubleshooting Reporting Issues

2. Select the BIAR file From the file system(you can browse to the file
path) and click Next.

3. Choose Destination Environment (CMS Name) as the BO server
(HPE OBR Application Server).

4. The BIAR file name.

5. Click Next.

6. Select Clear all, and then check only required objects:
« Import Application Folders & Objects

« Import Repository Objects
« Import Universe, then click Next.

7. Choose Update destination object, in case of name conflict,
rename it and Click Next.

8. Check all options and then click Next.
9. Click Next.
10. Select the folders and objects then click Next.
11. Click Next on the Select application folders and objects screen.

12. Selectthe 3rd option from import options for universe and
connections, and then click Next.

13. Select the universe(s) from the Universe folder and Universes
screen.

14. Select Import recipients..., and then click Next.
15. Click on Finish to complete the deployment.

16. Click on View Detail Log to see the status of deployment, and then
click Done.

On Linux

When HPE OBR is installed on Linux, install the SAP BusinessObjects
client tool on a Windows system (BusinessObjectsXI-3.1-
Clienttools.zip; available in the packages/BO directory on the

HPE OBR Linux media) and follow the steps to import the BIAR file on
Windows.

Symptom Weblogic CSVs are stuck in Collect folder

Description Weblogic CSVs are stuck in Collect folder due to issues in
Orchestration.
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Resolution To resolve this issue, follow these steps:
On Windows:

1. Go to Start > Run, type services.msc.

2. Right-click HPE_PMDB_Platform_Orchestration and click
Restart.

On Linux: Run the following command:

service HPE _PMDB Platform Orchestration restart
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Chapter 6: Troubleshooting Data Source Issues

This section of the guide covers the possible Data Source issues and how you can
troubleshoot them.

HP Operations Agent Data Source Issues

Symptom  Checking Data Availability on HP Operations Agent using
JCODAUTIL?

Resolution Setthe environment variable in the command prompt to get additional
options.

C:\>SET CODAMAGIC=0x05201993

1. To dump latest data in the data source for all instances, run the
following command in the system where Agentis installed:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -dumpds
<datasource>
Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -dumpds SCOPE
For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -dumpds <datasource>
Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -dumpds SCOPE

2. To dump metric list of a data source and a class, run the following
command in the system where HPE OBR is installed:
For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -n <hostname> -obj
Example: %ovinstalldir%/jre64/bin/java -jar
%#0OVINSTALLDIR%/java/jcodautil.jar -n pihptl.
example.domain.com -obj
For Linux: /opt/HP/BSM/JRE64/bin/java -cp
/opt/0OV/java/ -jar /opt/OV/java/jcodautil.jar -n
<hostname> -obj
Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/OV/java/
-jar /opt/0OV/java/jcodautil.jar -n pihptl.
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example.domain.com -obj
3. To dump last data for a data source and a class:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated_metrics> -
last

Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
last

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated _metrics> -
last

Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -n

pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
last

4. To dump first data for a data source and a class:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0VINSTALLDIR%/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated metrics> -
first

Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
first

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated_metrics> -
first

Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
first

5. To dump last hours’ summarized (by five min) data for a data
source and class:

For Windows : %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds <datasource> -o
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<class> -n <hostname> -m <comma_separated metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -s fivemin

Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
b 07/18/2012.10:00:00 -e 07/18/2012.11:00:00 -s
fivemin

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated_metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -s fivemin

Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/OV/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
b ©7/18/2012.10:00:00 -e 07/18/2012.11:00:00 -s
fivemin

6. To dump last hours’ raw data for a data source and class:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -raw

Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
b 07/18/2012.10:00:00 -e 07/18/2012.11:00:00 -raw

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/OV/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated _metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -raw

Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
b ©7/18/2012.10:00:00 -e 07/18/2012.11:00:00 -raw

7. To dump last hours’ summarized (by five min) data for a data
source and class in a CSV format:

For Windows: %ovinstalldir%/jre64/bin/java -jar
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%0OVINSTALLDIR%/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -s fivemin -1 "," > file.csv

Example: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m BYCPU_ID,BYCPU_STATE -
b ©7/18/2012.10:00:00 -e 07/18/2012.11:00:00 -s
fivemin > cpu.csv

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds <datasource> -o
<class> -n <hostname> -m <comma_separated metrics_
list> -b <mm/dd/yyyy.hh:mi:ss> -e
<mm/dd/yyyy.hh:mi:ss> -s fivemin -1 "," > file.csv
Example: /opt/HP/BSM/JRE64/bin/java-cp/opt/0OV/java/-
jar

/opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -n
pihptl. example.domain.com -m

BYCPU_ID, BYCPU_STATE -b ©7/18/2012.10:00:00 -e
07/18/2012.11:00:00 -s fivemin >

cpu.csv

Symptom HP Operations Agent Connectivity Issues

Description HP Operations Agent Connectivity Issues, check the reachability and
availability of data source for reporting.

Resolution Perform the following steps:

1. Check that the host is reachable.
For Windows: -ping <hostname>
For Linux: ping -n <hostname>
If ping fails, check the connectivity to the host.

Note: If the node is behind a firewall, ping might be blocked.

2. Check to see if the agentis up and running using following
command:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ping <hostname>

For Linux: /opt/HP/BSM/JRE64/bin/java -cp
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/opt/0OV/java/ -jar /opt/OV/java/jcodautil.jar -ping
-n <hostname>

Ping of OvBbcCb and CODA should be successful. But if the
jcodautil ping fails, check the status of agent by running ovc -
status command on the agent system and check that all the
services are running as shown in the following sample output:

Sympto Empty CPU Data for Last Two Days
m

Descripti No data availability on source
on

Resoluti Perform the following steps:

on 1. Check that the host is reachable.

For Windows: -ping <hostname>
For Linux: ping -n <hostname>
If ping fails, check the connectivity to the host.

Note: If the node is behind a firewall, ping might be blocked.

2. Check to see if the agent is up and running using the following
command:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0VINSTALLDIR%/java/jcodautil.jar -ping -n <hostname>
For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ping -n <hostname>
Ping of OvBbcCb and CODA should be successful. But if the
jecodautil ping fails, check the status of agent by running ovc -
status command on the agent system and check that all the
services are running as shown in the following sample output:
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3. Check to see if data is being collected and logged in HP Operations
Agent by running the following command:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -m
BYCPU_ID,BYCPU_CPU_TOTAL_UTIL -last -n <hostname>

Example: %ovinstalldir%/jre64/bin/java -jar
%0VINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o CPU -m
BYCPU_ID,BYCPU_CPU_TOTAL_UTIL -last -n piiatil.
example.domain.com

For Linux: /opt/HP/BSM/JRE64/bin/java -cp /opt/0OV/java/
-jar /opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -m
BYCPU_ID,BYCPU_CPU_TOTAL_UTIL -last -n <hostname>
Example: /opt/HP/BSM/JRE64/bin/java -cp /opt/OV/java/ -
jar /opt/0OV/java/jcodautil.jar -ds SCOPE -o CPU -m
BYCPU_ID,BYCPU CPU TOTAL_UTIL -last -n piiatil.
example.domain.com

Time CPU Total
Stamp ID CPU %
03/26/12 5:05:00 0 0.78
03/26/12 5:05:00 1 1.92
03/26/12 5:05:00 2 2.33
03/26/12 5:05:00 3 2.07
03/26/12 5:05:00 4 1.19
03/26/12 5:05:00 5 2.45
03/26/12 5:05:00 6 1.17
03/26/12 5:05:00 7 1.10

If you don’t see data for the last two days, contact HP Support.

Symptom Data Holes in Reports
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Description No data availability on source

Resolution Perform the following steps:

1. Check that the host is reachable.
For Windows: -ping <hostname>
For Linux: ping -n <hostname>
If ping fails, check the connectivity to the host.

Note: If the node is behind a firewall, ping might be blocked.

2. Check to see if the agentis up and running using following
command:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%OVINSTALLDIR%/java/jcodautil.jar -ping -n
<hostname>

For Linux: /opt/HP/BSM/JRE64/bin/java -cp
/opt/0OV/java/ -jar /opt/OV/java/jcodautil.jar -ping
-n <hostname>

Ping of OvBbcCb and Coda should be successful. But if the
jcodautil ping fails, check the status of agent by running ovc -
status command on the agent system and check that all the
services are running as shown in the following sample output:

3. Run the following command to check if you have one row every
five minutes between the given start and end time:

Start and end time format are mm/dd/yyyy.hh:mi:ss.

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ds SCOPE -o
GLOBAL -m GBL_MEM_UTIL,GBL_CPU_TOTAL UTIL,GBL_DISK_
UTIL -b ©03/25/2013.10:00:00 -e 03/25/2013.11:00:00 -
n piiatl. example.domain.com

For Linux: /opt/HP/BSM/JRE64/bin/java -cp
/opt/0OV/java/ -jar /opt/0OV/java/jcodautil.jar -ds
SCOPE -0 GLOBAL -m GBL_MEM_UTIL,GBL_CPU_TOTAL_
UTIL,GBL_DISK UTIL -b ©3/25/2013.10:00:00 -e
03/25/2013.11:00:00 -n piiatl. example.domain.com
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Symptom Missing Dimensions — HPE OBR Displays One Instance when
Multiple Instances Exist

Description No data availability on source.

Resolution Perform the following steps:

1. Check that the hostis reachable.
For Windows: -ping <hostname>
For Linux: ping -n <hostname>
If ping fails, check the connectivity to the host.

Note: If the node is behind a firewall, ping might be blocked.

2. Check to see if the agent is up and running using the following
command:

For Windows: %ovinstalldir%/jre64/bin/java -jar
%0OVINSTALLDIR%/java/jcodautil.jar -ping -n
<hostname>

For Linux: /opt/HP/BSM/JRE64/bin/java -cp
/opt/0OV/java/ -jar

/opt/0V/java/jcodautil.jar -ping -n <hostname>
Ping of OvBbcCb and Coda should be successful. But if the
jcodautil ping fails, check the status of agent by running ovc -

status command on the agent system and check that all the
services are running as shown in the following sample output:
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3. Check the availability and integrity of data sources by performing
the following steps:

a. Launch the following page:

http://<HPE OBR Server
FQDN>:<port>/BSMRApp/dscheck. jsf

b. To check the data sources in the HP Operations agent, click
PA.

Click View to see the results. Results include a status summary
of nodes and missing policies.

4. Check the last logged data time stamp for each instance. Check
that all missing instances are listed and that the time stamp is the
same as with the instance that displays data in HPE OBR.
%ovinstalldir%/jre64/bin\java -jar
%0OVINSTALLDIR%\javaljcodautil.jar -ds DBSPI_ORA_
REPORT -o DBSPI_ORA_REPORT -last -n <hostname>
C:\> %ovinstalldir%/jre64/bin\java -jar
%OVINSTALLDIR%\java\jcodautil.jar -ds

DBSPI_ORA REPORT -o DBSPI_ORA_REPORT -last -n
USNYCDBS

example.test.com

=== 03/26/13 9:15:00 PM

Instance 0

INSTANCENAME p123

METRICID 119.00

VALUEID 1.00

VALUE 109.71

SYSTEMID example.test.com
OBJECTID p123

==03/26/13 9:15:00 PM
Instance 1

INSTANCENAME p123
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Symptom

Description

Resolution

Symptom

Description

Resolution

METRICID 201.00

VALUEID 1.00

VALUE 5.00

SYSTEMID example.test.com
OBJECTID p123

Microsoft SQL servers take up a new CIID when data sources are
recreated in HPOM

The collection module obtains same Microsoft SQL server instance
with a different CIID when data sources are recreated on the HPOM
because the instance key metrics of SPI is used to generate the CI_
UID. When DSl logging is enabled (default mode) on the SPI source
instead of the HPOM, no metrics are marked as key metrics. But, ifitis
changed, the instance_name becomes a key metric which generates a
different C1_UID.

Create the %0VDATADIR\conf\dsi2ddf\nocoda.opt file in Windows
and the /var/opt/0V/conf/dsi2ddf/nocoda.opt file in Linux to
make the SPIlog to HPOM instead of DSI (on recreation) so that

HPE OBR always obtains the key metrics.

Data loading into HPE OBR fails due to NaN values

When data collection from HP Operations Agent attempts to load Not a
Number (NaN) values into the numeric columns of fact tables, data
type conversion errors are seen. The error can be viewed from the
Administration Console > Internal Monitoring > Data Process
Status > Content Pack Component Name (SysPerf_Domain) where a
count of errors is listed.

Browse to the {PMDB.HOME}/config/collection.properties file
and add the following property:

pa.metric.default.metric.list=10,13.
Restart the HPE_PMDB_Platform_Collection service.

All NaN values are replaced and data loading occurs properly.
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Note: This workaround might impact performance because each
metric collected from the HP Operations agent data source
undergoes validation.

Symptom Finding Attribute Value for the Cl Type — HP Operations Agent
Description Finding Attribute Value for the Cl Type — HP Operations Agent.

Resolution Perform these steps:

1. Right-click Computer and select Show Element Instances. A pop
up appears with the Cl instances and their attributes.

Fthe selected query node are displayed n the table.

|| stowcinsiances of: [ Computer 20| Iy Bl:t|a|= 8-
Display Label | | monitoreaBy | ciType
& wrioss1ss 085155 [OM, NNV] t
B wrioss1s 1088156 [OM, NNMY
B iw105159 (Management Server) WH085159 [0M, NN
B wriossten 105160 [OM, NNM] unix
& witoss164 WH0B5164 fom
= witoss168 05166 Tom)
& witoss203 WH05203 fom
& witoseo7a
& witoso7s
& witoseo77
& witoseo79
& witos9109
=1 8 wricastas
T SM_Hyperv & nwriosores
1] SM_HyperV_BusinessView & wtogsrer
EEI- E itozoras
T &M DA Rucinooo\iow (@] - sannnaan

2. Ifthe PrimaryDnsName attribute of Computer Cl Type is blank for a
CI's (host) in that view, it will not be configured for collecting
performance metrics.

To verify whether the same number of data sources is discovered
in HPE OBR, follow the steps:

a. Log on to the Administration Console:
http://<hostname>:21411/BSMRApp
b. Navigate to the Data Source Configuration page.

c. Click HP Operations Agent to verify the number of data
sources.

RTSM Data Source Issues

Symptom Test Connection on Administration Console to RTSM Fails
Description Test Connection on Administration Console to RTSM Fails

Resolution Perform the following step:

For a BSM distributed setup, ensure that you have provided the
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hostname and port of the Data Processing Server and not the Gateway
Server.

Symptom Data Collection from RTSM - discovered HP Operations Agent
Nodes Fails

Description Data Collection from RTSM - discovered HP Operations Agent Nodes
Fails

Resolution Perform these steps:

1. Log on to BSM console from the URL http://<bsm_host_
name>/topaz.

2. Navigate to Admin > RTSM Administration.

4  Business Service Management - Site Map Ful StreenView  User:acminstrator |

+, MyBSH_Applcsons v LUl Hep v Sie ap

Service Heath

Applcatons || Adminsaton Service L ‘

Operations Hangement Change the defaut page..

End User lanagement

MyBSM Diagnostics
Disgnostics
Business Process sight

Transaction Management

Service Health System Avalibity Hanagement Transaction Management
360° View | Custom Image | 4 prayy Administration ighborhood Map | Shimi | Sujatha HTCHE | n Transaction Summary - Transaction Summary Report | Web Session Report
Topology Map | Top View | W|
Platform Transaction Analysis - Transaction Over Time Report | Transaction Tracking Report | Event Analysis Report
Transaction Topology - Aggragated Topol Component Topols
CI s'a'us Integrations. pology - Aggreg: pology | e pology
Linkto This Page. Transaction Infrastructure - Application Server Statitics Report | WenSphere NQ and JMS Statisics Report
KPls Summary
P Personal Settings
s Trem -
System Availability Management
KPls Distribution Qver Time <
SiteScope Over Time Reports - Monitor Performance | Cross-Performance | Group Performance | Status Summry |
KPls Over Time Warming Summary | Enior Summary
Cl Status Alerts. Ewvent Log
@ Service Level Management I UserReports

3. Navigate to Modeling Studio.

5]  Business Service Management - RTSM Administration FulSreenView  User: administrotor  (FESG80
G -, SN _Appicatins v Adrin v fiep v Sielap
e

[ Modeing
Modeing g|_ Dota Flow Wanagement | Adrinistraton t

IT Universe Manager 7 @ CIType Manager 7 %}

Dislay he topology of a view, showing the resus ofcanfigring your T Universe model (TaL View and iy the defnions of confguration tem types (CTs) defined 1 he RTSH and the

queries and views). You ean also view properties and reated configuraton s (C). relaonships hat defie the connections between them

Modeling Studio <T> Enrichment manager 7 ]
Lt W

Create and edi models, which ble collctons ofC, and create and et i M Enables you t add and delete Clnstances n the RS, as wel as update thei vale using &

base on models andor on coliections of Cs. Enrchment nodes and relsionships ekmerts

Impact Analysis Wanager 7 @4

Defin the infrdependencies between the components n your I infastruchure to st how %@

085 YOU Wantto make mpact your system

4. On the Resources tab, expand HP-SHR > SM > SM_PA and
double-click SM_PA view.

5. On the right hand pane, the view appears. Click the calculator icon
and check the number of instances of Configuration ltem (Cl) Type
Computer.
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Hodeing > Modeling Studio

Hodeling |DutuF\anunuqement Administration

Resource + Edt~ View~ Layout~ Operafions = Ftor fer+ Tools v

# New - [ B2 o

Resouress | e 1Ty TTsvpax
e B fet

BXg=s@ayFng g
= m— I ©) SRSl

Duter (2
,9' p ¥ Composttion_6 (
\

K .0
/e Compt\smorbw (
’,Comuoswt on (28 U)\

)
OV g \\
v peratons AT o Somua
qent (28) re(0)

|_FA_Businessliew
g

;[ SM_SiS_BusinessView

i
leEe 0 e =

m SM_VMWare_Business\View "

‘Legend. Z Contact Node ¥ External U Has Conditions @ Hes Idenfies B Hidden in Query Resuits ¥ Model Output & Subgraph

3

o A A

In the preceding sample, there are 28 instances of Cl Type Computer.
This indicates that there must 28 agent data sources from where
HPE OBR collects performance metrics and reports on System

Infrastructure Management.

Symptom Getting Number of objects visited by compound link calculation is
[200000001], while the limit is configured to [200000000] with large

RTSM setup

Description The Number of objects visited by compound link calculation limit by

default is configured to [200000000] in the

tql.compound.link.max.visited.objects property.

You may get Number of objects visited by compound link calculation is
[200000001], while the limit is configured to [200000000].

Resolution To resolve this issue, perform these steps:

1. Log on to the JMX console on the DPS server.
2. Goto UCMDB:Service=Settings Services
3. Modify the setSettingValue

a. customeriD: 1

b. name: tql.compound.link.max.visited.objects

c. value: 400000000

4. Restartthe HPE OBR collection service and verify the

topologycollector. log for errors.
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BPM and RUM Data Source Issues

Symptom

Checking Whether BPM Agents are configured

Description Checking Whether BPM Agents are configured

Resolution

Symptom

Perform the following steps:

1. Log on to BSM console from the URL http://<bsm_host_
name>/topaz.

Go to Admin > End User Management.

[A) Business Service Management - Site Map

Service Health

380° View | Custom Image | G

Cl Status

WG - MyBSM  Applications » — Help = Site Map
Service Health
Applications Administration Service Level Management

Operations Management

End User Management
Business Process Insight
System Availability Management
RTSM Administration

Platform

Integrations

Link to Thiz Page

Personal Settings

KPls Summary

KPls Trend

KPls Distribution Owver Time
KPls Orver Time

Cl 5tatus Alerts

pology Map | Top View | Watch List

3. Navigate to Settings > select Business Process Monitor
Settings and select BPM Agents.

WyBSH  Applcatons v Admin v e v Sie Hap

[0 Busines Servics Menagement - End User Management Admimshaicn

8.

FullSereen View  User: adminstrtor - [*LgoUt™)

‘ Sefings.

Hontoring Serpt Repostory Herls “

Setings P | Busness Pocess NoritorSetings| Real User Montor Setings
CHEMApms )PMLioerlse B Dt e BPMNobe Devices
Giox Big &R
HostName = 1P Address Locaton Vesin | LstPigTine | Tonsacions | Weblraces | Remobe | SavelPs | lockel ||
\ | I | | | | | | I \H
M 61844145 Bangabre W SBEEEN 4 2 .

4. Verify that BPM Agents are configured in BSM.

Checking Whether RUM Agents are configured
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Description Checking Whether RUM Agents are configured

Resolution To check whether Real User Monitor (RUM) agents are configured,
perform the following steps:

1. Log on to BSM console from the URL http://<bsm_host_
name>/topaz.
2. Go to Admin > End User Management.

[ Business Service Management - Site Map
- MyBSM  Applications — Help » Site Map

i

— Service Health
Applications Administration Service Level Management

Operations Management

End User Management

MyBSM : :
Business Process Insight
ﬁ System Availabilty Management
. RTSM Administration
E Service Health Platform
260° View | Custom Image | Integrations pology Map | Top View | Watch List

Link te Thiz Page

Cl Status Personal Settings
M KPls Summary

KPls Trend

KPls Distribution Cwver Time
KPls Ower Time

Cl Status Alerts

3. Navigate to Settings > Real User Monitoring Settings and select
RUM Engines.

[0 Business Service Management - End User Management Adminsliabon Ful eV User s (T80T
1 @ o v, MEsH Aplcatins v Adnin v Hep v Sieliap
B

‘ Setings ‘

Montoring Script Repostory Alerts ‘

Settings

Blox b

Engine: Name Host Name IP Address Version Last Ping Time Renovable | In Use n
\ | Ll LT[ B*

shrbal shrbafl 1618441125 9200 40306154 PH = vl

o
( RUM Engnes ) RUMLicerse  RUM Defout Sengs

4. Verify whether RUM engine is configured in BSM.

SiteScope Data Source Issues

Symptom  How many SiteScope servers is HPE OBR reporting on?

Resolution 1. Log onto BSM admin console fromthe URL http://<bsm_host_
name>/topaz.

2. Navigate to Admin > RTSM Administration.
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vice Management - Ste Map

WyBSH _Appcatons + LU ULy e v _Siellap

N Senvi e
Appleatins || Adminstraton Senice L ‘

Operatons Hanagerent Change the default page... »

End User Wanagement . y
MyBSM Diagnostics
Diagnostics
Business rocess insight
Transachion Management
Service Health System Avaiabity anagenent Transaction Management
360 View | Custom Image | 6 75y Adrinistration ighbahood Map | Shimi | Sujatha HTCH? | Transzotion Summary - Transaction Summary Report | Web Session Repat
Topology Map | Top View W}
Pltform Transaction Analysis - Transaction Over Time Report | Transaction Tracking Report | Event Analysis Report
‘Transaction Topology - Aggregated Topal Componet Topolt
Cl Status Integrations pology - Aggreg: palogy | Comp pology
Pl Sumary Linkto This Page Transaction Infrastructre - - Sphere 1Q and JI &
P Personal Seffings
s Ten -
System Availability Management
KPls Distibution Over Tine <
Site Scope Over Time Reports - Monitar Perormance | Gross Performance | Group Performance | Staius Summary |
KPls Over Time. Warning Summary | Enor Summary
CI Status Alerts EventLog
@ Service Level Management . UserReports

3. Navigate to Modeling Studio.

s Service Management - RTSM Administration User:adminstraor ~ (PEGGE0T
& - - WBSH_Appicaons v Admin v Hop v Siliap
A a4

‘Mndehng

Modelng g _Data Fow ianagement | Adminstration £
IT Universe Hanager ? @ ClType Manager 2 %
Display thetopoogy of 8 view, showing the resuts of configurng your T Universe modelTaL View and modity th defintonsof configuraion e types (CTs)defind nthe RTSH and he
queris and viws). You ca also view properies and relted confuraon tems (Cls) reatonsips that defne th comnectons between them.

TS 7

- u ‘ Enrichment manager /\qﬂ
Create and et modes, which rereusable colections of s, an ereat and e perspeciv views H Enables youto add and delete Clnsiances inth RTSH, 5 wel s updat thei vaue usng ~

based on models andlor on collections of Cs. Enrichment nodes and relationships elements.
Impact Analysis Manager 7 O“

Define th between the components in your IT ‘simulate how u@

nfrastrcture changes you want o make impactyour st

4. From the Resources tab, expand HP-SHR > SM > SM_SiS _
Server and double-click SM_SiS_Server view.

5. On the right-hand pane with view detail, the instances of Cl Type
Computer are the number of SiteScope Servers that HPE OBR
reports on.

[ neig > Hodeng St

Modeing i Data Flow Management Administration

Resource ~ Edt+ View~ Layout+ Operations+ Flfor fem~ Tools v

& New B [m]

Resuroes [Clssecor OTgesl | W 515 Server X
— (Gl o
@xonsarERs . |

Resource Type: | [ Views ('] ]T»@@ b

“

Virtial- Jain_
30

—];[ SM_Hyper/

—];[ SM_Hyper\/_BusiessView
SEETIN

*1;[ SM_PA BusinessView

/
,ﬁomposwt\on_1 (i
S

Virtual - Join_
0

/

¥ aripastion (0)
0

i
-leBEleo 0 2 =
@
e

SiteSeope Profi
B HP Operations A ItledSobea k(1)
L aent (0) el
—m SM_Sol_Zones_BusinessView 12
LD s v
T s ke ‘ Legend: 2 ContctNode % Extemal U Hes Condions  Hes dentes B Hiddenin Query Resuts ¥ NodelOutput & Subgraph %

—m SM_VMWare_BusinessView '] ']

. " R

6. To check the SiteScope servers, right-click on the Computer Cl
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type and select Show Element Instances. Check the
PrimaryDnsName attribute. HPE OBR uses this attribute to
configure collection and get the performance metrics about the
remote servers configured on SiteScope.

Cllnstances e |
@ ClI Instances
Al Clinstances of the selected query node are displayed in the table.
|| srowcimsances o [Comerts 7] 3|10 G| ¥ ¥R = = B -
Display Label | PrimaryDnsName | Monitored By CI Type

[ wf1089178 wi089178 [SiteScope] nt

Total rows: 1 Rows per page: 50 hd ‘

Symptom  How many Servers (Windows/UNIX) does SiteScope Server
Monitor?

Resolution 1. Log on to SiteScope server using the following URL.:
http://<hostname>:.8080/SiteScope/servlet

2. Go to Remote Server.

[ SiteScope

‘ ‘ﬂ‘q' Renotes on Mcrosofl Windows enote Servers

2%| 8% %
Name = Sever | Siaus | lasilest | Opemtingsysten |  Method |  Descripon | Associted monitors
i, IWFVNODHBHPSW.. NFVMIOHLPS.. G YOISAHPN  Windows NeBI0S 3

Ef;’ﬂ IWFVMO1238 hpswiabs adapps.hp.com
7 piatt ind hp.com

Symptom  Checking Whether BSM Integration is enabled on the SiteScope
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Server

Resolution 1. Log on to SiteScope home page.
2. Go to Preferences > Integration Preferences.

3. An integration entry for BSM appears when SiteScope is added in
BSM.

[ SiteScope
Page Options + Help «

Integration Preferences
|‘.§“‘ General Preferences
* & K| Ty
qu Infrastructure Preferences Integration Name |
| BSM integration on bsmr-vm17 | BSM integration for profile sis11
Ejl Integration Preferences HP Operations Manager integration on bsmr-vmi 7 Metrics integration is enabled
| £ Edit BSM Integration Preferences ﬁ
BSM Integration Main Settings

Note: The BSM credentials are used for reporting hoth data (BSM Profile List) and topology in secure mode.

# Business Service Management machine name/|P address: |bsmr—vm1 7 ‘

# SteScope agent machine location: |pmdbqavm4 ‘

D Disakle all logging to Business Service Management
# The registration settings below are associated with the profie:  =is11

Business Service Management user name |admin ‘

Business Service Management user password: | ----- ‘

| Web Server Security Settings |
[ |
| Proxy Server Settings |
[ |
| Topology Reporting Settings |
[ |
BSM Preferences Available Operations

Peset/Delete all integration related settings:

Force SiteScope to synchronize configuration with Business Service Management

Hard synchronization (Warning: forces a deletion of the entire profie configuration before the data is resent):

All managed nodes from SiteScope are automatically synced to
BSM when the integration is complete. You can perform a Re-
Synchronize or Hard Re-Synchronize operation if required.

Symptom  Checking Whether CODA Integration is enabled on the SiteScope
Server

Resolution 1. Log on to SiteScope home page.
2. Go to Preferences > Integration Preferences.
3. Anintegration entry for BSM appears when SiteScope is integrated
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to CODA.

[ SiteScope

Page Options + Help «

Integration Preferences

|§ General Preferences

£ 2 R| % %

4&» Infrastructure Preferences

Integration Name |

| BSM irtegration on bamr-ym17

| BSM irtegration for profile siz11

Ej Integration Preferences

HP Cperations Manager integration on bsmr-vm17

Metrics integration is enabled

4. Ifintegration is not listed in the above screen, Click on the * icon
and select HP Operations Manager Integration.

Enable SiteScope to integrate with HP Operations agent for data
logging. For more information, see the Working with Operations
Manager and BSM Using the HP Operations Agent chapter of the

Using SiteScope Guide.

[£] HP Operations Manager Integration ﬁ, -

+le
HP Operations Manager Integration Main Settings =]
I Connection Settings
HP Operations Agent installation path: | C:\Program Files\HP\HP 8TO Softwaret [l Resolve Path |
HP Operations Manager / BSM host ( bsmr-ym17 \J | Connect | Install Policies | Analyze |
Enter BSM server name
Configuration Settings
["] Enable sending everts
[ onnect directly to BSM
[[] Prefer everts over metrics in BSM Service Health (global preference)
Enable nade discovery policy
HP Manager Setting: = | =
Event Integration Settings
Test message: | - 3
Severity Mappings
Erro
warning
Goad [Normal [~
U lable: Unknown |+ |
Iefault severit
Enable this option for
HP Cperations Manager Metric Integration collected data to CODA. [
( Enable HP Operations Manager metric integration ] -
k) [ Ok Cancel | -

Symptom
CODA

Resolution 1.

Checking Data Availability for SiteScope Performance Metrics in

HPE OBR queries CODA data store running on SiteScope server

to get performance metrics for reporting.
2. The data source that HPE OBR queries to get SiteScope data is

HPE Operations Bridge Reporter (10.00)
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AGENTLESS.

3. HPE OBR queries follow classes within AGENTLESS data source
to get performance data.

a. GLOBAL

MEMORY

DISK

SYSTEM
QUEUE__LENGTH
QUEUE__STATISTICS
UPTIME
PHYSICALDISK

i. 10 STATS

NETIF

k. NETWORK__INTERFACE
|. NETWORK__STATS
m. CPU

n. FILESYSTEM

4. See the Troubleshooting HP Operations Agent Data Source Issues
for details on how to check availability for a class and data source.

Q@ -0 2 0o T

(S

Symptom Mapper (data transformation step) crashes when collecting data
from SiteScope Profile Database

Description When HPE OBR collects system performance data (initial history) from
the SiteScope profile database, the mapper crashes due to low system
memory.

Resolution Browse to the {PMDB.HOME}/config/collection.properties file.
Edit this property--mapper.memory.map.size=30000. The default
value is 30,000. Decrease the value (for example: 20000) until mapper
runs smooth with available memory.

Symptom Out of Memory Error with Mapper during SiteScope/HP Reporter
Data Processing

Description Mapper goes "out of memory" when processing data from
SiteScope/HP Reporter when all metrics expected by HPE OBR are
not being logged with valid data.
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Resolution You can tune the following parameters to handle this issue:

o Add or update
mapper.incomplete.data.dump.batch=30000 in the
{PMDB_HOME}/config/collection.properties file to batch the
data in chunks for handling high load scenarios.

o Add orupdate mapper.incomplete.data.indicator=true
in {PMDB_HOME }/config/collection.properties file to indicate
mapper to take up the preceding batching logic.

o Update mapper.cache.key.retry.count=2 in {PMDB_HOME}
/config/collection.properties file to indicate mapper to wait
only for a couple of runs for processing late arriving data.

HPOM Data Source Issues

Symp HPOM Policy for alerts on Linux does not exist
tom

Desc The OM policies shipped with the productin $PMDB_HOME / config folder
riptio were installed as per instructions provided. This is done to monitor services
n through OM policies. The expectation is to receive alerts on OM when

HPE OBR services on Linux go down.

To test the policy, services were brought down manually but no alert was
sentto OM. A Linux version of HPOM Policies for alerts is required.

Resol To resolve this issue, perform these steps:
ution | ist of Policy:
SHR _collection_pause
SHR_collection_jobs
SHR_hourly tables
SHR _daily tables
SHR_insufficient_vm
SHR_streams
SHR_boinfoview_connectivity

SHR_dwh_connectivity

SHR_mgmt_connectivity
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SHR Windows Collector Service
SHR Windows Service

SHR ABC Process Count

SHR PostgreSQL Database Process
SHR Sybase IQ Database Process

1. Perform these steps on OM server to extract the policies:
a. Copythe SHR_OM_Policies.zip to atemp folder and extract it.
b. Goto <temp_folder>\SHR_OM_Policies folder.
2. Perform these steps on OM server to install the policies:
a. Goto<temp_folder>
b. Run following command:

On Windows: ovpmutil cfg pol upl <full path to_temp_
folder>/SHR_OM Policies/PolicyConfig ©.xml

On Linux: /opt/0V/bin/0OpC/utils/opcpolicy -upload
dir=<full_path_to_temp_folder>/SHR_OM Policies
mode=replace

On a successful run of the preceding command, OM displays the
policies with version ©920.0 under Policy Groups/SHR_
SelfMonitoring in the HPOM console.

3. You will see the following on HPE OBR server:
« Following entries in %PMDB_HOME%\1ib\trendtimer.sched

« #Every 3 hours monitoring jobx

03:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name dwh_
connectivity -1 {PMDB_HOME}/temp -sendomevent

03:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name mgmt_
connectivity -1 {PMDB_HOME}/temp -sendomevent

03:00 - - {PMDB _HOME}/bin/shr_utility -systemcheck -name
boinfoview_connectivity -1 {PMDB_HOME}/temp -sendomevent

03:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name
collection _pause -1 {PMDB_HOME}/temp -sendomevent

03:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name
collection_job -1 {PMDB_HOME}/temp -sendomevent

« #Every 6 hours monitoring jobx
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06:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name
hourly tables -1 {PMDB_HOME}/temp -sendomevent

« #Every 6 hours monitoring jobx

24:00+1:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name
daily tables -1 {PMDB_HOME}/temp -sendomevent

24:00+1:00 - - {PMDB_HOME}/bin/shr _utility -systemcheck -name
streams -1 {PMDB_HOME}/temp -sendomevent

24:00+1:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -name
insufficient_vms -1 {PMDB_HOME}/temp -sendomevent

4. Perform these steps on HPE OBR server to configure email alerts once a
day:

» Following entries are found in the location %PMDB__
HOME%\1ib\trendtimer.sched

24:00+1:00 - - {PMDB_HOME}/bin/shr_utility -systemcheck -1
{PMDB_HOME}/temp -sendemail

« Edit%PMDB_HOME%/data/config.prp and add following properties to
send email:

email.to=
email.from=
email.host=
email.port=25

email.auth=false
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Chapter 7: Troubleshooting Client Authentication
Certificate Problems

Client Authentication Certificate Issues

Symptom Unable to Logon to HPE OBR after Enabling Client Authentication
Certificate

Description Administration Console:
Log file location: Check the log file located at the following location:

« Windows:
Check the logs located at %PMDB_HOME%/adminServer/logs
catalina.<YYYY-MM-DD>. log
hpshreporter-stderr.<YYYY-MM-DD>. log
hpshreporter-stdout.<YYYY-MM-DD>. log

o Linux:

Check the Catalina.out log file located at $PMDB_
HOME/adminServer/logs.

Launch pad Console:

« Windows:
Check the logs located at %PMDB_HOME%/BOWebServer/logs
catalina.<YYYY-MM-DD>. log
boel20tomcat-stderr.<YYYY-MM-DD>. log
boel20tomcat-stdout.<YYYY-MM-DD>. log

o Linux:

Check the Catalina.out log file located at $PMDB_
HOME /BOWebServer/logs

You will see the following error message in the log file:

PKIX path validation failed .Could not determines
revocation status.

This occurs when the CRL URL configured for certificate revocation
is not reachable through the configured HTTP proxy host/port or
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HTTPS proxy host/port. To identify this issue, enable Certificate
Path Tracing as follows.

Resolution 1. Change the HTTP proxy host or HTTPS proxy host so that
CRL URL is reachable. Make changes in the respective
configuration files as specified in the Client Authentication
Certificate for HPE OBR section of the HPE Operations Bridge
Reporter Configuration Guide.

2. Stop the service.

3. Execute the PERL command as mentioned in the Client
Authentication Certificate for HPE OBR section of the HPE
Operations Bridge Reporter Configuration Guide.

4. Start the service.

Symptom Login to Administration Console Fails after Enabling Client
Authentication Certificate

Description After selecting the certificate, Administration Console checks for the
username extracted from the certificate in SAP BusinessObjects
Central Management Console under Administrator group. If the user
does not exist, the following message is displayed.

This ste s pmt@{:tbd o mﬂy athorzed Ermorto login Ertarpree aulkertication could not log you an. Flease make sure yourlogen infamatian is
personne] can aceess the system. e

[ Logonwi & dgial cerlficats

Resolution Perform these steps:
1. Log on to SAP BusinessObjects Central Management
Console.

2. Create the User as per the Username Extraction configured in
the server.xml file.

3. Assign it to the Administrators group.

Symptom Administration Console Prompts for Username/ password after
Configuring Client Authentication Certificate

Description It happens when the properties of config.prp are not set properly as
mentioned in the Client Authentication Certificate for HPE OBR section
of the HPE Operations Bridge Reporter Configuration Guide.
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Resolution Check the following properties from the config.prp file located at
1 %PMDB_HOME%/data (Windows), $PMDB_HOME /data (Linux)
1. shr.loginMethod is set to certbased

2. shr.auth.classes is set to
com.hp.bto.bsmr.security.auth.BOTrustedAuthenticator

Resolution 1. Check the date of the logon.jsp file located at %PMDB__
2 HOME%/BOWebServer/webapps/InfoViewApp/logon.jsp

2. Ifthe current system date does not reflect, change to it.

Symptom  Administration Console Log on Failure

Description After enabling Client Authentication Certificate, log on to
Administration Console fails. The log file displays the following
message:

SEVERE: Exception invoking periodic operation:
java.lang.OutOfMemoryError: GC overhead limit exceeded

« Windows:

hpshreporter-stderr.<YYYY-MM-DD>.1log and
catalina.<YYYY-MM-DD>. log located at %PMDB_
HOME%/adminServer/logs.

o Linux:
Catalina.out located at $PMDB_HOME/adminServer/logs

This issue occurs when the list of the certificates to be downloaded
from the CRL distribution point for the verification of certificate
revocation is too large.

Resolution To overcome this issue, Java heap space needs to be included.
Perform the following steps to increase the heap space:
Windows:

1. Go to Start > Run, type services.msc. Right-click HPE_
PMDB_Platform_Administrator service and click Stop.

2. Editservice.bat located at %PMDB __
HOME%/adminServer/bin

Edit -XX:MaxPermSize=256m, --JvmMx 256 : Increase
the value as per the size of the CRL URL.

3. Increase MaxpermSize as per the requirement.
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4. Recreate the service.
Go to %PMDB_HOME%/adminServer/bin,
service .bat remove C:/HP-SHR/
service.bat install C:/HP-SHR/
Linux:
1. Run the command service HPE_PMDB_Platform_
Administrator stop.

2. Editthe catalina.sh located at $PMDB__
HOME/adminServer/bin folder.

3. Edit the MaxPermSize argument -XX:MaxPermSize=256m of
JAVA _OPTS

4. Run the command service HPE_PMDB_Platform_
Administrator start.

Enabling Certificate Processing Trace

Solution The system property -Djava.security.debug=certpath of the Java
Runtime Environment (JRE) can be set to enable the tracing of certificate
processing. The outputis very useful for developers and support
validation of the user certificate, including the processing of the certificate
revocation.

Steps Perform the following steps to enable certificate path tracing:
Windows:

1. Go to Start > Run, type services.msc.

2. Right-click HPE_PMDB_Platform_Administrator service and
click Stop.

3. Editservice.bat located at %PMDB_HOME%/adminServer/bin

Include -Djava.security.debug=certpath as partof JVM
Arguments.

4. Recreate the service.
Go to %PMDB_HOME%/adminServer/bin,
service .bat remove C:/HP-SHR/
service.bat install C:/HP-SHR/
Linux:

1. Run the command service HPE_PMDB_Platform_
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Administrator stop.
2. Editthe catalina.sh located at $PMDB_HOME/adminServer/bin

Include -Djava.security.debug=certpath as partofJVM
Arguments.

3. Run the command service HPE_PMDB_Platform_
Administrator start.
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Chapter 8: Troubleshooting High Availability (HA)
Issues

Symptom SHR_HA_Setup.pl Errors during Execution

Description SHR_HA_Setup.pl located at %PMDB_
HOME%\HA\Veritas\Windows\SetupScripts for Windows, $PMDB__
HOME/HA/Veritas/Linux/SetupScripts for Linux errors out at
execution.

Resolution Make sure Shared drive is available and re-run the script.

Symptom SHR_HA_Setup.pl Fails to Initialize in Second Node

Description SHR_HA Setup.pl fails to initialize in the second node when using
default file located atthe %PMDB_HOME%/data folder.

Resolution Copy config.prp from the first node to the %PMDB_HOME%/data folder
of second node and rerun the script.

Symptom SHR_HA_Setup.pl Returns the “Not able to update ovcert” Error
Message

Description SHR_HA_Setup.pl returns the “Not able to update ovcert” Error
Message

Resolution 1. Check the output of the following command:
ovcert -status to see if all servers are running.
2. Runthe ovc -check command.

If any of the mentioned services fails to provide the required
output, execute the following commands:

e Oovc -kill

e Oovc -start

Symptom After running SHR_Linux_vcsconfiguration.pl Script, HPE OBR
Services Show as Unknown
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Description After running SHR_Linux_vcsconfiguration.pl Script, HPE OBR
services show as Unknown.

Resolution = Run the following commands:
$VCS_HOME/bin/hastop -local -force
$VCS_HOME/bin/hastart

Symptom Service status appears to be “Fault” in VERITAS Service due to
PostgreSQL.

Description VERITAS shows the service as faulted. PostgreSQL server fails to
start when it encounters permission issues on its data folders. The
corresponding error message “Permission denied on any of the
files/folders in postgres data directory” is observed in the log at %pmdb_
home%/ . ./Postgres/data/log folder.

Resolution Change the owner of both the folders under <shareddrive>/HP-
HPE OBR/PostgreSQL folder to administrator and run the following
command:

CACLS <shareddrive>\HP-HPE OBR\PostgreSQL\data /T /E /P
<hostname>\postgres:F

Following symptoms and solutions are specific to HA (Windows)
environment.

Symptom Connection Failure to Administration Console, Launch pad, and
CMC using Logical Name of Cluster

Description Connection Failure to Administration Console, Launch pad, and CMC
using Logical Name of Cluster

Resolution 1. Check whether the logical name is DNS resolved.
2. Run the following command:
nslookup <logical IP>orping -a <ip>
3. Check whether the logical name is presentin config.prp.

4. In case the hostname is not DNS resolved, it can be replaced
with IP address as workaround.

Symptom IP Resource in VERITAS not coming up
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Description IP Resource in VERITAS not coming up.

Resolution 1. Check that the logical IP, subnet mask, primary node name,
secondary node name, and their MAC address is correctly
configured in VERITAS.

2. Check that the logical IP is not present in the network settings.

Symptom During Failover to other Node, Tomcat Service does not Stop
Gracefully

Description During Failover to other Node, Tomcat Service does not Stop
Gracefully

Resolution = This happens very intermittently. It takes lot of time and hangs while
stopping. Kill the process manually from Task Manager.

Symptom During Secondary Node Setup, Servers in SAP BusinessObjects
Stop and do not Come Up

Description During Secondary Node Setup, Servers in SAP BusinessObjects Stop
and do not Come Up.

Resolution This is expected behavior. The server (HOMLO1GEATON) is deleted
during the secondary node setup and is replaced with HASHR. It
should be up and running and vice versa for primary node.

Symptom Failed to start SQLAnywhere service on a HA node

Description Sometimes you may get the following error when the SQLANYs__
BOE120SQLAW service fails to start on the HA node. The issue is
because the link is not created to shared drive when you execute the
HA script.
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Resolution Check for the link in <bodrive>/program files x(86)
/businessobjects/sqlanywherel2/bin directory. Iflink is not
available, create a link manually and try to start the SQLAnywhere

service.

Execute following command to create the link:

mklink /D bin<Shared disk bin location>

Forexample: C: \Program Files (x86)\Business
Objects\SQLAnyWherel2>mklink /D binG:\HP-

SHR\BusinessObjects\SQLAnyWhere12\bin.
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Chapter 9: Troubleshooting Disaster Recovery
Issues

Symptom Deleting Server Intelligence Agent failed

Description While restoring the SAP BusinessObjects Database and File Store in
Windows, deleting Server Intelligence Agent using the command sc
delete boel2@sia<name> there may be several causes which lead
to the service being stuck in “marked for deletion” and you may get the
following message:

[SC] DeleteService FAILED 1072:

The specified service has been marked for deletion.

Resolution To resolve this problem, perform the following :

To ensure all instances are closed, run taskkill /F /IM mmc.exe.

Symptom Reports not accessible after restoring the SAP BusinessObjects
Database and File Store

Description After restoring the SAP BusinessObjects Database and File Store in
Windows, the user is not able to access the reports the following
message is displayed:

The document can't be retrieved from repository server WIS 30951.

Resolution To resolve this problem, perform the following :
1. From the Start menu, type Central Management Console in
Search. The Central Management Console page appears. OR
Log on to CMC from the following url:
https://<HPE OBR_System FQDN>:8443/CMC
Log in to CMC with Administrator account.
Click Servers.
Right-click on InputFileRepository server.
Click on Properties.

o gk w N

Set the Temporary Directory path. (For Example: <installation
directory of BOE>:\Program Files\Business
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Objects\BusinessObjects
Enterprisel2.0\FileStore\Input\Temp)

7. Setthe File Store Directory path. (For Example: <installation
directory of BOE>:\Program Files\Business
Objects\BusinessObjects
Enterprisel2.0\FileStore\Input).

8. Click Save & Close.
9. Restart the InputFileRepository server.
10. Perform the steps from 4 to 9 for OutputFileRepository server.
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The Capture Tool

The Capture tool helps you capture useful configuration and run-time information from
HPE OBR systems that can be used for advanced troubleshooting. The Capture tool is
not installed on the HPE OBR system by default. You can install it on the HPE OBR
system, as well as on the system where the Vertica database for HPE OBR is installed.

To install the Capture tool:

Prerequisites

« All necessary Content Packs should be installed.
« The HPE_PMDB_Platform_Administrator process must be running.

1. Log on as root/administrator and run the following command:
On Windows

%PMDB_HOME%\contrib\Supportability\capture_tool\capture_
toolInstall.bat

On Linux

$PMDB_HOME/contrib/Supportability/capture_tool/capture_
toolInstall.sh

2. Using the command prompt, change to the following directory:
On Windows
%PMDB_HOME%\adminServer\webapps\birt
On Linux
$PMDB_HOME/adminServer/webapps/birt
3. Run the following command:
On Windows

updatePasswd.bat <management database password for user pmdb_
admin>

On Linux

updatePasswd.sh <management database password for user pmdb_admin>
Executing the Capture Tool

The capture tool ships with an out of the box default configuration XML to captures the
required information. This XML contains the targets that have set of commands to run.

The capture configuration file shr_capture_tool options.xml islocated at {pmdb_
home}\contrib\Supportability\capture_tool\perl\.
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Run the following command to execute the capture tool:

For Windows:
%pmdb_home%\contrib\Supportability\capture_tool\perl\capturetool.bat
For Linux:
$PMDB_HOME/contrib/Supportability/capture_tool/perl/capturetool.sh
The data gets collected is in the location {pmdb_home}/capture_output

Note: If the folder {pmdb_home}/capture_output already has some data, then
post execution the Capture Tool will overwrite the data in that folder.

Interpreting Results

The out-of-the-box configuration file captures the following information:

« System configuration

« Product configuration

« PostgreSQL database

« Log File

« Installed Content packs

« Data source

« HPE OBR service status

« Data flow

o Orchestration stream status

These reports can be accessed from the link:
http://<hostname>:21411/birt/report.jsp

Note: By default all the information captured will be in any one of the following
format:

« CSV
o Text
e HTML
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Disable HTTPS Configuration

HPE OBR has two console interfaces, the Administration console and the

SAP BusinessObjects Bl launch pad. It is possible to run both the consoles in a secured
environment with HTTPS network protocol or in a non-secured environment with HTTP
network protocol. The default protocol for both the consoles is HTTPS. However, you
can disable HTTPS default configuration for Administration Console and SAP
BusinessObjects Bl launch pad console.

HP Operations Bridge Reporter recommends to use HTTPS as the default network
protocol.

For the Administration Console of HPE OBR

To disable a secure connection for the Administrations Console of HPE OBR:
Task 1: Stop the HPE_PMDB_Platform_Administrator service
To stop HPE_PMDB_ Platform_Administrator service, follow these steps:

« On Windows

a. Go to Start> Run, type services.msc.

b. Right-click HPE_PMDB_Platform_Administrator, and then click Stop.
e On Linux

Run the following command:

service HPE_PMDB_Platform_Administrator stop
Task 2: Edit the server.xml file

Tip: Take a backup of the server.xml file before editing.

Comment the SSL Connector tag that has the port value setto 21412.
Task 3: Comment the security constraint in web.xml
1. Browse to the following folder:

« On Windows

%PMDB_HOME%\adminServer\webapps\BSMRApp\WEB-INF
o On Linux

$PMDB_HOME/adminServer/webapps/BSMRApp/WEB-INF
2. Openweb.xml with a text editor.
3. Comment the following lines:
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<Connector port="21412"
protocol="org.apache.coyote.httpll.HttpllProtocol"
maxHttpHeaderSize="8192" connectionTimeout="20000"

maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
keyAlias="HPE OBR"

keystoreFile="../keystore/HPE OBR_CERT_HTTPS. jks"
keystorePass="shradmin" keystoreType="JKS" xpoweredBy="false"
server="HPE OBR"/>

Task 4: Start the HPE_PMDB_Platform_Administrator service

« On Windows

To start HPE_PMDB_ Platform_Administrator service:

a. Go to Start> Run, type services.msc.

b. Right-click HPE_PMDB_Platform_Administrator, and then click Start.
e On Linux

Run the command

service HPE_PMDB_Platform_Administrator start

Task 5: Verify the configuration.

To verify the configuration, log on to the Administration Console using the following
URL:

http://<hostname>: 21411

where, <hostname> is the name of the HPE OBR system.

For the SAP BusinessObjects Bl launch pad Console of HPE OBR

To disable HTTPS communication for SAP BusinessObjects Bl launch pad Console of
HPE OBR:

Note: In a custom installation of HPE OBR, perform the following tasks on the
system where SAP BusinessObijects is installed.

Task 1: Stop the SAP BusinessObjects Webserver service

To stop the SAP BusinessObjects WebServer service:
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o On Windows

a. Go to Start> Run, type services.msc.

b. Right-click BusinessObject WebServer, and then click Stop.
e On Linux

a. Goto /opt/HP/BSM/PMDB/BOWebServer/bin

b. Run the following command:

./shutdown.sh

Task 2: Edit the server.xml file

Tip: Take a backup of the server.xmlfile before editing.

To edit the file, follow these steps:
1. Open the server.xml file located at %PMDB_HOME%\BOWebServer\conf (for
Windows) or $PMDB_HOME /BOWebServer/conf (for Linux):
2. Commentthe SSL Connector tag that has the port value set to 8443.
Task 3: Start the SAP BusinessObjects WebServer

To stop SAP BusinessObjects WebServer service:

o On Windows

a. Go to Start> Run, type services.msc.

b. Right-click BusinessObject WebServer, and then click Start.
« On Linux

a. Goto /opt/HP/BSM/PMDB/BOWebServer/bin

b. Run the following command:

./startup.sh

Task 4: Verify configuration

To verify whether the configuration is successful, follow these steps:

1. Logonto http://<hostname>:8080/BI

where, <hostname> is the name of the HPE OBR system.
2. Logontohttp://<hostname>:8080/CMC

or

https://<hostname>:8443/CMC

where, <hostname> is the name of the HPE OBR system.
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Generating Reports to Stream Mapping Information

Follow the commands described in the readme. txt packaged along with it to install the
utility. Run the following command to get the streams associated with a report:

shr_utility - rept -name <name of the report> -1 <output location>

This command generates a ReportToStreamMapping.html file.

Checking if Data is stuck in Source Table

Launch PostgreSQL interface (Start > Program Files > PostgreSQL 9.3 > pgAdmin lli
Run the following SQL.:

SELECT name_,value_ FROM job_stream_dt stream,job_stream step dt
step,job_stream_step_metadata_dt metadata

WHERE stream.hjid=step.job_stream dt hjid

AND step.hjid=metadata.job_stream_step dt_hjid

AND stream.dwid="<stream name>"'

AND step.dwid=’<step name>’
AND name_=’targetTable’

In the generated output, there is a key value pair. It represents metadata associated with
the step. Look up the generated output for a key called sourceTable and targetTable
(Value_ preceding with SR _) as show in the following figure.

Query max (ta_period) from source and target tables and check that the difference does
not exceed six hours.

9 Query - dwabc on postgres@localhost:21425 *

File Edit ©Cuery Favourites Macros Yiew Help
‘0 - ‘ .E;Jy ‘ [al ) ‘ oL‘ ‘ 2 %% DE B W ‘ ID dwabe on postares@localhost: 21425 j
S Editor | @raphical Guery Builder I

I j Delete Delete all

GSELECT name_,walue_ FROM job_streaw dt stream,job_stream step_dt step,job_stream step_metadata dt metadata

WHEFE stream.hjid=step.job_stream dt_hjid

AND step.hjid=metadata.job_stream step dt_hjid

AND stresm.dwid='RUMEFacts_TCPapplication' —

AND step.dwid='Dataload TCPipplication’ -
dl | ;H

-

Output pane
Data Output |Explain I Messages | Histary |

name_ |va|ue_ ‘
b L PLTAN L POLT N
1 Isour:eTable SR RUM TCPApplication I
2 I
3 targetTable E RUM AppTier
4 targetTable F CI Application
5 |targetTable E CI SoftwareElement
[ targetTable E FEUM Client
T targetTable E Location
i} targetTahle K CI Svsten
a targetTable E Customer
10 |rargetTahle E CI EndlUsersGroun
11 targetTable E CI Subnet
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CLI Reference Information

This section provides reference information of key command line utilities provided by
HPE OBR.

Orchestration Module (ABC)

The Orchestration Module (ABC) - Audit, Balance and Control utility is used to control
data flow of the following streams to respective data warehouse tables:

« ETL stream to the stage tables

« DWH stream from stage tables

The streams that load data into data warehouse cubes are called as DWH stream. DWH
stream are responsible for moving data from stage table to DWH tables and
aggregations. DWH stream has steps like LOAD, HOURLY_AGGREGATE, DAILY_
AGGREGATE and EXEC_PERL.

ETL stream transforms the collected data from the data sources to stage tables. ETL
stream contains steps like COLLECT, TRANSFORM, RECONCILE and STAGE.

For information, see Architecture chapter in HPE Operations Bridge Reporter Concepts
Guide.

abcimportDef

This command is responsible for importing/updating/deleting the stream definition in the
platform. Importing of stream definitions takes place during the Content Pack installation.

Usage abcimportdef [-help] [-verbose] [-xmlfile <xmlfile>] [-
xmlfile <xmlfile> -delete]
o To import the definition files:
abcimportdef -xmlfile <xmlfile>
where, <xmlLf1ile> is the name of the stream definition file.
o To delete the stream:
abcImportDef -delete -xmlfile <xmlfile>
where, <xmlLf1ile> is the same stream definition file that is imported.

Options  « delete - delete stream
e help - print this help message
e verbose - verbose output
o xmlfile -load the XML file into the metadata repository
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o returns -0 for success
1 for success with warning(s)
>1 for error(s)

Example « Toimport the definition files:
abcimportdef -xmlfile ..\sampledata\sample.xml
o To delete the stream:
abcimportdef -delete -xmlfile..\sampledata\sample.xml

Log File = {PMDB_HOME}/log/dw_abclauncher.log

abcAdminUtil

This command can be used to perform the following tasks:

« Set the maximum number of retries per job step.
Set the maximum execution time per job step.

Set the pool count for a resource type.
To abort all or a particular stream that is running

Usage abcAdminUtil -setMaxRetries [-streamId <stream name> -
stepId <step name> -value <number>] | -setMaxExecTime [-
streamId <stream name> -stepId <step name> -value <number>]
| -setResourceCount [-resourceType <resource type> -value
<pool count>] | -pause | -resume | -abort [-streamld
<stream name> | -all]

o To set maximum retries:

abcAdminUtil -setMaxRetries -streamId <stream name> -
stepId <step name> -value <number>

e To0 set maximum execution time:

abcAdminUtil -setMaxExecTime -streamId <stream name> -
stepId <step name> -value <number>

e ToO setresource count:

abcAdminUtil -setResourceCount -resourceType <resource
type> -value <pool count>

« To pause the Orchestration operation:

abcAdminUtil -pause

This command can be used to pause a running stream temporarily.
« Toresume the Orchestration operation:
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abcAdminUtil -resume
This command can be used to resume a paused stream.
« To abort the specified stream:
abcAdminUtil -abort [-streamId <stream name>]
This command can be used to abort a specific running stream.
« Tokill all currently running streams:
abcAdminUtil -abort [-all]
This command can be used to abort all running streams.
» Reset all the steps with Running and Starting state to waiting state:
abcAdminUtil -resetSteps
This command can be used to reset streams to waiting state.

Options help - print usage

e pause - to pause the Stream operations

» resetSteps -toreset all the steps with Running and Starting state to
Waiting State.

e resume - to resume the stream operations
« setMaxExecTime - to set maximum execution time for specified step

o stepId <stepId> -step ID of the stream for which a value need to be
set

e streamId <streamId> -stream ID of the stream for which a value
need to be set

e value <value> -value that need to be set

« setMaxRetries - to set maximum retries for specified step

o stepId <stepId> -step ID of the stream for which a value need to be
set

e streamId <streamId> - stream ID of the stream for which a value
need to be set

e value <value> -value that need to be set

» setResourceCount - to set resource count for specified resource type

e resourceType <resourceType> -resource type for which a value
need to be set

e vValue <value> -value that need to be set
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e abort - Admin Operation to ABORT

abcMonitor

e streamId <streamId> -stream ID of the stream for which a value
need to be set

e all - Admin Operation to ABORT ALL STREAMS

You can use this command to analyze the state of the data processes. This command is
responsible for monitoring and displaying the stream details along with the stream steps,
current and historical status of the streams and steps in its database schema.

Usage abcMonitor -streamdef | -stream <streamFilter> [ -step
<stepFilter> -export <csv_file location> ] | -log
<logFilter> | help | -runtimeRefresh

Option

To display all the Imported stream:
abcMonitor -streamdef
To display details of all stream:
abcMonitor -stream ID=ALL
To generate a .csv file that has details of all stream including all steps:

abcMonitor -stream ID=ALL -step ID=ALL -export <location
of csv>

To display all the step of a stream that completes with warning:

abcMonitor -stream ID=<streamID> -step
ID=ALL,status=warning

To display all execution log of step that completes with error:

abcMonitor -log stepID=<stepID>,Severity=error,Detail=true

streamdef - printimported streams
help - printusage

log <logFilter> - Display log detail based on following log filter
seperated by comma.

<stepID|processID=<stepid/processid>,Severity=WARN|ERROR,D
etail=true>

runtimeRefresh - Refresh run-time table

step <stepFilter> - Display step detail based on following step filter
seperated by comma:

<ID=stepID|All,
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state=WAITING|RUNNING|FINISHED, status=ERROR|MAX_EXECUTION
TIMEEXCEEDED | WARNING |NA|SUCCESS >

o stream <streamFilter>- Display stream detail based on following
stream filter seperated by comma.

<ID=streamID|All,
state=ACTIVE|ABORTED|FINISHED, status=ERROR | WARNING|NA|OK >

o export <csv_file_location> - write outputto given .csv file

o step <stepFilter> - Display step detail based on following step filter
seperated by comma:

<ID=stepID|All,
state=WAITING|RUNNING|FINISHED, status=ERROR |MAX_
EXECUTION TIMEEXCEEDED |WARNING |NA|SUCCESS >

Examp e« To generate a .csv file (C:/pmdbStreamSteps.csv)that has details of all
le stream including all steps:

abcMonitor -stream ID=ALL -step ID=ALL -export
C:/pmdbStreamSteps.csv

« Todisplay all the step of stream Test@3 that completes with warning:
abcMonitor -stream ID=Test@3 -step ID=ALL,status=warning

« To display all execution log of step Test3_C that completes with error:
abcMonitor -log stepID=Test3 C,Severity=error,Detail=true

abcStreamRunner

This command can be used to reload the stream and run it.

Usage abcStreamRunner [-streamId <stream name>] [-forcelLoad] [-
skipPrecheck] [-varArgs <varArgs>]

Options forcelLoad - Force loads a stream.

« help- printusage
o skipPrecheck - Skips the precheck for the stream.

e streamId <streamId> - The stream ID of the stream for which a value
need to be set.

e varArgs <varArgs> - The variable arguments file to be used for
sending arguments to the steps.

Example To run the stream with dwid Core@Dim_K_Person:

abcStreamRunner -streamId Core@Dim_K_Person

HPE Operations Bridge Reporter (10.00) Page 134 of 147



Troubleshooting Guide

DWH

Aggregation

This module is responsible for carrying out hourly and daily aggregation of performance
metrics collected from different sources. The aggregation is governed by aggregation
definitions, which are designed by the Content Pack developer and the initialization of
these definitions takes place at the time of installing the Content Pack. The initialization
process involves creation of the temp table used by the aggregate definition file.

Aggregate looks up aggregate control table in PostGreSQL and determines the time
beyond which data has to be processed in the current invocation. This aggregate
control table has two fields, last execution time and last process time. Last execution
time is used by daily aggregation to control the frequency of execution (By default daily
aggregates run once every 12 hours). Last process time is used by both the hourly and
daily aggregation procedures to perform incremental aggregation.

Source Table Rate/Hourly Table
Destination Table Hourly/Daily Table
Failure Directory Rate/Hourly Tables (Data is retained in the

source table on failures)
Log File {PMDB_HOME}/log/aggregate.log

Usage « config=<Aggregate Definition File> [The
aggregate definition file name is <source _
table>_<target_table>_<cubename>.xml in
{PMDB_HOME}/scripts]

« init=true/false [Invoking the loader
definitions initialization]

Loader

This module is responsible for moving data from stage table to DWH table. Loader does
the processing that involves resolving surrogate key and loading. The loader is
governed by loading definitions, that the content pack developer designs. The loader
definitions are initialized as part of content pack installation. Initialization process
involves creation of temp table used by loader.

All the Rate and dimension in HPE OBR has corresponding stage table. Stage table
name will generally be rate/dimension table name followed by an _. If the DWH table
name is SR_SM_NODE _RES than the stage table name for this DWH table will be SR_
SM_NODE_RES .
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Loader looks up stage_control table in PostGreSQL and determines the time beyond
which data has to be processed in the current invocation. This module also purges data
older than time mentioned in this stage control table.

Source Table Stage Table

Destination Table DWH Rate/Dimension table

Failure Directory {PMDB_HOME}/failed_to_load

Log File {PMDB_HOME}/log/reconcileStep.log
Usage » config=<Loader Definition File> [The name

of the definition File will generally be
<DWH_Table_Name>.xml and will be
under {PMDB_HOMEJ}/lib directory

« init=true/false [Invoking the loader
definitions initialization]

« perfLog=true/false [ Creates a performance
log file containing performance statistics of
the current loader execution]

ETL Modules

These modules are responsible for extracting data from the data sources, transforming,
reconciling and staging them into stage tables. ETL content pack consume these
modules to carry out data movement to staging area.

Collect

This module is responsible for moving data from {PMDB_HOME } /collect directory to
{PMDB_HOME }/stage directory. This does merging of files with same type and category
into a single file of configurable size (Default 25MB), unless there are left over files from
the previous cycle. This identifies the batch of data, which the streams picks up for
processing.

Source Directory {PMDB_HOME}/collect

Destination Directory {PMDB_HOME}/stage

Failure Directory None, files are left in the {PMDB_HOME}/collect
folder

Log File {PMDB_HOME}/log/collectStep.log
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Usage collect [-category <category>] [-type <type>]
« category - Specify the category of the
collected data
« type -Specify the type of the collected data
« help - Provides Help message

Collection_Config

This module is responsible for importing/updating/deleting the ETL artifacts. ETL
artifacts that are imported by collection_config are:

« Collection policies [PA, CMDB, SN, DB]

« Transformation Rules

« Reconciliation Rules

The imported rules are stored in the PostGreSQL management database. A cached
copy of these policies is stored in the {PMDB_HOME}/etl_rules folder. Al HPE OBR
ETL modules use rules from this cached folder instead of connecting to PostGreSQL.

Every time the collection_config module is executed, the cached copy is refreshed.

Usage

« collection_config -collect <Full path to collection policy xml file name> -cp
<contentpack name>

« collection_config -transform <Full path to transformation policy xml file name> -cp
<contentpack name>

« collection_config -reconcile <Full path to reconciliation policy xml file name> -cp
<contentpack name>

« collection_config -delete -cp <contentpackName>
« collection_config -refreshCache -transformRules
« collection_config -refreshCache —reconcileRules

Mapper

This module is responsible for transforming the data and preparing it for loading to
staging area. This module supports different types of transformation functions like, string
functions, arithmetic functions, duplicate removal functions, pivot transfer functions and
so on. These transformation function on the input data is defined by the content pack
developer and imported during content pack installation.
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Source Directory {PMDB_HOME}/stage

Destination Directory {PMDB_HOME}/stage

Failure Directory {PMDB_HOME}/failed_to_transform

Log File {PMDB_HOME}/log/mapperStep.log

Usage mapper [-category <category>] [-type <type>]

[stepid <id>]

« category - Specify the category of the
collected data

« type -Specify the type of the collected data

« stepld <step ID> - Specify the step id. Uses
this argument to build the output file name

« help - Provides Help message

Reconcile

Reconciliation is a two-step process for checking the performance metrics and their
dimensions discovered from topology sources. This involves:

1.

Building Registry
This process involves building a registry for reconciliation. This registry has a key
and a value for each dimension discovered from a topology source. The key is the

concatenated business key and value is the global unique identifier. The rule
specifies the column to be used for building the keys from the dimension CSVs.

Reconciliation of the performance metrics

This process is responsible for associating the global unique identifier with a
dimension. This is governed by the reconciliation rules, which define the
reconciliation registry to be used for the type and category of data. This also defines
the CSV columns from the collected data that can be used to build a key, to look into
the reconciliation registry of the identified type, and get its matching global unique
identifier.

Source Directory {PMDB_HOME}/stage

Destination Directory {PMDB_HOMEJ}/stage

Failure Directory {PMDB_HOME}/failed_to_reconcile

Log File {PMDB_HOME}log/reconcileStep.log
Usage reconcile buildRegistry [-category <category]
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[-type <type>] [-stepid <step ID>]

« buildRegistry - Build the registry

« category -Specify the category of the
collected data

« type - Specify the type of the collected data

« stepld <step ID> - Specify the step id. Uses
this argument to build the output file name

« help - Provides Help message

Stage

This module is responsible for loading the collected, transformed and reconciled data to
staging tables. The stage module is driven by stage rules that specifies how to move
data from source CSV to stage tables. All the Rate and dimension in HPE OBR has
corresponding stage table. No summarization tables will have an associated stage
table. Stage table name will generally be rate/dimension table name followed by an _. If
the DWH table name is SR_SM_NODE_RES, then the stage table name for this DWH
table will be SR_SM_NODE_RES .

Staging involves following two modes of execution,

1. Compiling the stage rules

In this mode, Stage module compiles and generates the compiled stage based on
input stage rules designed by the content pack developer. The stage rule
compilation occurs as part of content pack installation.

Compiled stage rules are stored in {PMDB_HOME } /stagerules folder and the XML
equivalent to this compiled stage rules is stored in {PMDB_HOME } /stagerules_
source folder.

2. Executing the data load from CSV to stage table.

In this mode, Stage modules takes the input as compiled stage rule and moves the
data from the CSV file to stage table. The information on the CSYV file patterns to be
picked and the stage table to load the data, is mentioned in the compiled stage rule.

There is some amount of processing that happens in the staging area. Important one
is to perform column merge across different fact CSV’s and move the resultant data
to stage table.

Source Directory {PMDB_HOMEJ}/stage
Destination Directory {PMDB_HOME}/stage/archive
Failure Directory {PMDB_HOME}/failed_to_stage
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Log File {PMDB_HOME}/log/stage.log
Usage
To Compile Stage Rule « compile=true [To invoke compilation mode.

Defaultis false.]

«» stagerule=<Stage Rule> [Full path to the
file that has stage definitions]

« interface=<Interface XML> [Full path to the
stage interface XML]

« outputLocation=<Output Directory>
[Directory where the compiled stage rule is
stored]

To Execute Stage table loading « config=<Compilied Stage Rule> [Path to
the compiled stage rule]

« printSourceFile=true [Generated XML
version of compiled stage rule. Provides
mapping between CSV columns and stage
table columns. Default value is false]

« debugOutputLoc= <Folderpath> [Location
where the XML equivalent of compiled
stage rule is placed]

Platform_modules

datapipe_manager

This module is responsible for creating/dropping the data warehouse tables in Vertica.
Along with creating or dropping table, the utility registers or deregisters the tables in the
metadata maintained by HPE OBR.

This module will be generally invoked for creating/dropping tables for Content Pack
installation and uninstallation activities.

Note: Stage tables are not part of data warehouse tables, and therefore, are not
created or dropped by the Content Pack installation/uninstallation process.

Log File - {PMDB_HOME}log/trend.log

Usage1:To Create a table « datapipe_manager -p create -a <path_to__
schema_definition_file>-d <debug_level>
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Usage2:To Drop a table « datapipe_manager -p delete -t <table> -d
<debug_level>

p [create|delete] create for creating table and delete for
deleting a table

a Full path to schema definition file. This file
has a property format called as TEEL and is
created by CDE by reading the model XML,

d Level of debugging information to be
generated. The data is logged to trend.log.
Supported debug logging levels are 1, 2, 3.

t The name of the table to be dropped.

extract

HPE OBR Collectors are launched from the windows service HPE PMDB Collection
Service. This module is responsible for launching standalone collector outside the
windows service.

This module reads information about what to collect from the policy file and run the
collection for the data source type specified as input. This module also takes the list of
data source, for which you want to run the data collection as input .

This can be used as a good data source troubleshooting module to isolate whether a
problem is due to data source or some thing else.

Log File - {PMDB_HOME}/log/collection.log

« {PMDB_HOME}/log/hpaCollector.log
{PMDB_HOME}/log/topologyCollector.log
{PMDB_HOME}/log/dbCollector.log

Usage « config - Specify the full path to the
configuration file

« help - Provides Help message

« policy - Full path to collection policy file(s)
(multiple files to be separated by comma

()

« type - Specify the collector type that needs
to be run PA|CMDB|DBI|SN
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Content of config.properties file for individual stand-alone collectors

PA hostname=<hostname>

init.history=<collection interval in minutes —
default to 60>

CMDB hostname=<hostname>
username=<rtsm username>
password=<rtsm password>
port=<rtsm port>

DB hostname=<hostname>
username=<DB username>
password=<DB password>
port=<DB port>
instance.name=<DB instance name>

db.name=<DB name>
use.windows.auth=<true|false>

db.type=<database type
oracle|mssql|Sybase>

datasource.type=<datasource type
generic|profile_database|OM|Omi>

SN hostname=<hostname>
username=<OM username>
password=<OM password>
port=<OM port>
instance.name=<OM instance name>
db.name=<OM DB name>
use.windows.auth=<true|false>
protocol=https
type=<OM type OMW|OMU|OML>

HPE Operations Bridge Reporter (10.00) Page 142 of 147



Troubleshooting Guide

packagemgrSlient

This module is responsible for deploying or undeploying a content pack. This module is
invoked from the Admin Ul deployment manager page. At any given point, only one
instance of packagemgrSilent should be running. This is enforced by the deployment
manager page. Deployment manager will not let user deploy/undeploy a content pack(s)
when already deployment or undeploymentis in progress.

Not just only one instance of packagemgrSilent should be running at a given point but
also there should not be any HPE OBR processes running at the time of invocation.
Even this is taken care by the Deployment Manager page in Admin Ul.

This module takes a file containing a list of content packs as input ,to be deployed or to
be undeployed. Since there can be dependency between the content packs, the input
file is expected to have content pack names in an order such that the dependency is
met. Again, Deployment manager takes care of building the ordered list of content packs
based on their dependency and invoke the packagemgrSilent.

Based on type of the content pack, a typical content pack installation involves

1. Placing artifacts in the PMDB directory to be consumed at run time by various
HPE OBR processes

Creating a schema in the Vertica DWH (Domain CP)

Importing the ETL artifacts (ETL CP)

Importing the stream definitions (ETL CP)

Initializing the loading procedures (Domain CP)

Initializing the aggregate procedures (Domain CP)

Compiling the staging procedures (ETL CP)

BIAR Deployment (Application CP)

© N O O WD

Log File {PMDB_HOMEJ}/log/packagemgr.log
{PMDB_HOME}/log/trend.log
{PMDB_HOME}log/collections.log
{PMDB_HOME}/log/stage.log

« {PMDB_HOME}/log/loader.log

« {PMDB_HOME}/log/aggregate.log

sqglexecutor

HPE OBR content uses stored procedure to carry out few data processing, which are not
possible using standard out of the box modules. Or they might have a specific use case
for aggregations. This module is also used as part of content pack installation to create
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stage tables. This module is responsible for executing any stored procedure. There are
two modes of operations
1. To execute sql script

In this mode the module takes a file containing SQL commands as input and
executes them.

2. Run/Drop for already created procedures
In this mode, the module executes the procedure passing required arguments.

Log File  {PMDB_HOME}/log/backend.log

Usages 1 « sqlexecutor -sqlscript <sqlscript Name> -
logdfile <logfile path>

Usages 2 « Sqlexecutor -execproc | -dropproc
<procedure Name> -procArgs

sqlscript File name that contains SQL commands

logfile Log file

dbisql Additional options that are supplied for script
execution

execproc To execute the procedure specified as value

for this option

dropproc To drop the procedure specified as value for
this option
help Command line help

Known Limitations in HPE OBR Reports

When data is gathered from HP SiteScope (data collection from RTSM/BSM Profile
database), certain known limitations or gaps existin HPE OBR reports of Systems and
Virtualization content packs.

System Management

The following table lists the known gaps in HPE OBR reports when data is sourced from
HP SiteScope (BSM Profile database):

Report Known Limitations

SM Heat Chart No data available in Physical Disk and Network tabs
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Report Known Limitations
SM System Usage Detail No data available in Physical Disk and Network tabs

Virtualization

The following table lists the known gaps in HPE OBR virtualization reports when data is
sourced from HP SiteScope (BSM Profile database):

Note: Only VMware virtualization is supported by HP SiteScope integration with
HPE OBR. Hence, only this virtualization technology appears across the reports
when data is sourced from SiteScope.

Report Metrics that are unavailable in reports with
SiteScope integration

SM Virtualization Host Inventory Processor Architecture, Disk Count, VM Count

SM Virtualization Logical System = State, Number of Disk, Number of LAN, Minimum
Inventory CPU Entitlement, Maximum CPU Entitlement

SM Virtualization Logical Systems Logical System Physical CPU Utilization
Performance Summary

SM Virtualization Top and Bottom = OS Type, Average Physical CPU Utilization (%),

N Logical Systems Average Physical Memory Utilization (%)
SM Virtualization Top and Bottom = Processor Architecture, Number of Logical
N Nodes Systems, Average Grade of Service

SM Virtualization Virtual Logical System OS

Infrastructure Inventory

SM Virtualization Logical System  Physical CPU Utilization
Performance Details

SM Virtualization VMware ESX Number of disks, Number of network interfaces
Server Detail Inventory

SM Virtualization VMware Cluster CPU Capacity, Number of Network Interfaces
Detail Inventory unavailable in VMware ESX Node inventory

VMware ESX Resource Pool Inventory tab will
be empty

CPU Limit, Number of disks, Number of network
interfaces unavailable in Logical System
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Report Metrics that are unavailable in reports with
SiteScope integration

Inventory
SM Virtualization VMware Number of disks, Number of network interfaces,
Inventory CPU Unreserved

SM Virtualization VMware Logical Average Physical Memory Utilization Percentage
System Memory Bottleneck
Details

SM Virtualization VMware Top Average Swap Utilization (%)
and Bottom N ESX Servers

SM Virtualization VMware Top Average Physical CPU Utilization (%),

and Bottom N Logical System Average Physical Memory Utilization (%)
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by
email. If an email client is configured on this system, click the link above and an email
window opens with the following information in the subject line:

Feedback on Troubleshooting Guide (Operations Bridge Reporter 10.00)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web
mail client, and send your feedback to docfeedback@hpe.com.

We appreciate your feedback!
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